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Unless indicated otherwise, the material in this workbook applies to all editions of Dragon, and 
the screenshots are from the Professional Individual edition.  

This workbook assumes that Dragon 15 is now installed on your PC. For details on how to 
install, including installing over a previous version, please see the Installation Guide on the 
Nuance website.  

 

 
 

 

The Quick Card includes important notes about installing as well as punctuation, numeric 
data, and commands.  

The online Knowledge Base contains the latest information written by Technical Support, the 
latest printable documents, as well as details on recorders and other hardware tested with 
Dragon. 

The Nuance website (www.nuance.com/dragon, australia.nuance.com/dragon, 
newzealand.nuance.com/dragon, and www.nuance.co.uk/dragon) offers many other resources 
including videos and Customer Service information.  

It also lists Value-Added Resellers who provide support, training and customization 
services in person or remotely. These partners can address your environment, equipment, 
and goals; this is particularly efficient for busy people, for people new to computers, for 
children, and in case of issues with hearing, vision, mobility or dyslexia.  
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Goals and Prerequisites 
Dragon is software for Windows computers that lets you speak naturally to perform actions such as creating or 
editing documents, using e-mail, finding online maps, news, images, and more. By reducing keyboard and mouse 
usage, you can gain productivity AND avoid physical strain (on wrists, shoulders, neck, eyes…)  

“Speaking to” your PC may feel strange at first. Be patient with yourself! This workbook aims to efficiently present 
what an end-user should know: most importantly, how to “type by voice” efficiently. This includes: 

• Dictating anything: punctuation marks, prices, dates, URLs, phone or plate numbers, abbreviations, 
acronyms, Roman numerals, etc. 

• Personalizing the Vocabulary with custom words and phrases, pronunciations, capitalization properties 
and more, so that Dragon can transcribe exactly what you want, even if what you said could be written in 
different ways. 

• Correcting Dragon’s errors so that it can learn from them. 

• Formatting, editing, and revising text, whether or not it was created by voice. 

• Creating custom commands to insert boilerplate text and/or graphics. 

 
In addition, you can learn how to command your computer by voice, which includes: 

• Saying commands to use the Web and e-mail, search your computer, open programs, click menus and 
buttons, close or minimize windows, switch between windows, etc.  

• “Voice-pressing” a key (or key combination) on your keyboard. 

 

To perform the exercises in this workbook, you should have basic familiarity with: 
• Using Microsoft® Windows® to start or exit applications, open or save files, copy or move items, browse 

to folders, cut and paste, etc. 
• Word-processing concepts such as bullets, font size and style, bolding, italicizing, and right-aligning. 

 

Efficiency and hands-free usage 
We strongly recommend going through this workbook in order. When a lesson directs you to click an item (button, 
menu…), feel free to instead use your voice, or keyboard shortcuts (underlined letters, Tab, spacebar…). If 
hands-free usage is important to you, start by reading the lesson Controlling the Operating System and 
Applications and see the Help about MouseGrid and commands for moving, clicking, and dragging the mouse. 

 

IMPORTANT: Starting the Microphone Check or the Interactive Tutorial automatically turns off Dragon’s 
microphone, which means a manual action is then needed to resume using Dragon. If this is a concern for you, 
we recommend having a helper with you when you create or upgrade a profile, use the Interactive Tutorial, or use 
the Microphone Check.  

 



Copyright  2016 Nuance Communications, Inc. All rights reserved v 

 

Table of Contents 
Goals and Prerequisites ............................................................................................................................................ iv 

Efficiency and hands-free usage ....................................................................................................................... iv 

Table of Contents ....................................................................................................................................................... v 

Getting Started and Creating a Profile........................................................................................................................1 

Positioning and connecting your microphone .................................................................................................... 1 

Upgrading one or more profiles .......................................................................................................................... 2 

Creating your profile—or adding an audio source ............................................................................................. 3 

About spoken recordings as source ................................................................................................................... 4 

Adding and managing sources ........................................................................................................................... 4 

Important options ................................................................................................................................................. 5 

Learning More and Getting Help ................................................................................................................................8 

The Accuracy Center ........................................................................................................................................... 8 

The Help ............................................................................................................................................................... 8 

The What Can I Say command ........................................................................................................................... 8 

The Interactive Tutorial ........................................................................................................................................ 9 

The printable guides ............................................................................................................................................ 9 

Why Personalizing the Vocabulary is Essential ...................................................................................................... 11 

Customizing the Vocabulary—Using the Vocabulary Editor ................................................................................... 12 

Adding vocabulary entries ................................................................................................................................. 12 

The importance of spoken forms ...................................................................................................................... 14 

Deleting “words” and modifying word properties ............................................................................................. 15 

Importing Lists of Vocabulary Entries ...................................................................................................................... 18 

Customizing the Vocabulary from Existing Documents ........................................................................................... 20 

Customizing the Vocabulary from Your E-Mail ........................................................................................................ 23 

Starting to Dictate: Controlling the Microphone ....................................................................................................... 26 

The DragonBar and the microphone icon ........................................................................................................ 26 

Microphone commands and sleep state .......................................................................................................... 28 

The importance of hot keys, including Microphone On/Off ............................................................................. 28 

Starting to Dictate: Your First Dictation ................................................................................................................... 30 

Dictating text and punctuation marks ............................................................................................................... 30 

New line and new paragraph ............................................................................................................................ 30 

The Results Display and its options ................................................................................................................. 31 



Copyright  2016 Nuance Communications, Inc. All rights reserved vi 

 

Dictating Prices, Units, Dates, Times, Addresses… ............................................................................................... 33 

Automatic text formatting during normal dictation ........................................................................................... 33 

Numbers Mode................................................................................................................................................... 35 

Spell Mode ......................................................................................................................................................... 35 

The Spell Command: characters within Normal Mode .................................................................................... 35 

Correcting Dragon’s Errors in Your Dictated Text ................................................................................................... 37 

Handling multiple matches in your text ............................................................................................................ 37 

The Correction Menu: the default interface ..................................................................................................... 38 

Correcting in the Spelling Window .................................................................................................................... 38 

Using playback to aid correction ....................................................................................................................... 41 

Smart Format Rules........................................................................................................................................... 42 

Editing Text by Voice ............................................................................................................................................... 44 

Navigation and selection ................................................................................................................................... 44 

Handling multiple matches in text ..................................................................................................................... 45 

Direct editing: Bold | Underline | Capitalize | Copy | Delete | Cut… ............................................................... 45 

Full Text Control, “unknown” text fields and the Dictation Box ....................................................................... 46 

Replacing and inserting ..................................................................................................................................... 48 

Formatting Text by Voice ......................................................................................................................................... 51 

The "X that" convention ..................................................................................................................................... 51 

The "Format That" commands .......................................................................................................................... 52 

Controlling the Operating System and Applications ................................................................................................ 55 

Searching the computer .................................................................................................................................... 55 

Controlling programs and windows .................................................................................................................. 55 

Resizing and switching ...................................................................................................................................... 56 

“Clicking” menus, buttons and other controls .................................................................................................. 57 

Natural Language Commands and the Command Browser ........................................................................... 58 

“Voice-pressing” keys ........................................................................................................................................ 58 

Using Dragon with the Internet ................................................................................................................................ 62 

The Web shortcuts ............................................................................................................................................. 62 

Social Media ....................................................................................................................................................... 63 

The browser extensions .................................................................................................................................... 63 

Navigating to and within a Web page (Internet Explorer) ............................................................................... 64 

Accessing a specific item on a Web page ....................................................................................................... 64 

Using Dragon for E-mail .......................................................................................................................................... 66 



Copyright  2016 Nuance Communications, Inc. All rights reserved vii 

 

Shortcut commands ........................................................................................................................................... 66 

Commands for your installed email program ................................................................................................... 66 

Web-based email and the Dragon extension................................................................................................... 67 

The Office Ribbon and Microsoft Word ................................................................................................................... 69 

The Ribbon interface ......................................................................................................................................... 69 

The File tab ........................................................................................................................................................ 69 

Read Mode ......................................................................................................................................................... 69 

Discovering commands ..................................................................................................................................... 69 

“Voice Notations” in Word documents .............................................................................................................. 70 

Dictating and editing in Microsoft Excel ................................................................................................................... 71 

Boosting Productivity with Custom Commands ....................................................................................................... 74 

Creating boilerplate commands ........................................................................................................................ 74 

“Cloning” commands and adding variables ..................................................................................................... 76 

Boilerplate commands with fields ..................................................................................................................... 76 

Managing custom commands ........................................................................................................................... 77 

Finding commands: the Keyword Filter ............................................................................................................ 78 

Performing Audio Checks and Training ................................................................................................................... 80 

The Microphone Check ..................................................................................................................................... 80 

Acoustic training in isolation .............................................................................................................................. 80 

Using Multiple Vocabularies .................................................................................................................................... 82 

Opening a Vocabulary ....................................................................................................................................... 84 

Acoustic and Language Model Optimization ........................................................................................................... 85 

Launching the Acoustic and/or Language Model Optimization ...................................................................... 85 

Scheduling Optimization and User Experience Collection ............................................................................. 86 

Renaming, Deleting, Copying or Transferring a Profile ........................................................................................... 88 

Practice Exercise: Creating a Memo by Voice ........................................................................................................ 90 

Index ........................................................................................................................................................................ 91 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 1 

 

Getting Started and Creating a Profile 
Dragon is speaker-dependent. It relies on information specific to you, including what words and phrases you use 
often, how you sound, what audio device you use, and what settings you have; it stores this in a set of files 
referred to collectively as your “user profile” or just “profile.”  

Each person who uses Dragon must have his or her own profile. Your profile is important; the more personalized 
it is, the better your experience will be. To have the best start, it’s worth creating your profile carefully or 
upgrading it from a previous version of Dragon.  

This lesson will cover creating or upgrading a profile. But first, let’s address what Dragon needs in order to get 
good audio input from you.  

 

Positioning and connecting your microphone 
If using a headset, adjust it so that it feels stable and comfortable; it shouldn’t press 
your temple or glasses.  The microphone’s listening side must face the side of your 
mouth, not the front.  It mustn’t touch hair or catch breathing sounds. (On standard 
headsets, bend the “boom” if needed.)   

Most headsets can be rotated so you can place the microphone on either the left or 
the right side of your face. 

Experiment to find what works best for you then aim for consistency in your 
microphone position whenever you use Dragon. 

 

IMPORTANT: 

• Noise-canceling microphones only listen on one side. The listening side is often 
marked by a dot or the word TALK, which may not be visible unless you lift the 
foam cover slightly. Check that this side is parallel to your face, not tilted. 

 

 

 

 

 

 

• If you want to bypass your computer’s sound system, you can use a USB 
microphone, or plug your regular microphone into a USB adapter. 

 
 

• If your computer has only one audio jack (socket) and you want to use a regular 
two-plug microphone, you must use a USB adapter or a Y-shaped adapter. 

 
 

• When you plug a microphone or adapter into your PC, be sure to push all the way into the audio socket or 
USB port. 

 

• If you want to test your microphone independently of Dragon, you can use Sound Recorder, a Windows 
accessory (accessible from the Windows Start menu or Start screen).  
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• You may also wish to check the audio settings at the level of 
Windows: see the “Recording devices” section of the Control 
Panel. This is accessible by right-clicking the loudspeaker icon 
on the System Tray. (In the example illustrated here, both 
Bluetooth and USB are available.) 

 

 

 
 

• Some PCs, after you connect a microphone, automatically 
bring up a small window associated with this “audio system 
event”. (Its window may be hidden behind other windows.) 
Before closing this window, verify that what is highlighted on it 
is the Microphone item (and not the Line In item).  

 

 

 

 

• If your microphone model has a mute switch, make sure it is in the ON position! 

• If you use a Bluetooth microphone: whenever you use Dragon, make sure that it is not only powered up but 
also active (that is, in “call mode”). Please see your microphone’s user guide for details, including how to 
charge the headset and how to pair it if necessary. 

 

Upgrading one or more profiles 
Dragon 15 can upgrade profiles from Version 13 or 14. If you have such a profile, you should upgrade it and use 
it in Dragon 15; this allows you to benefit from refinements you had previously made, including acoustics, optional 
settings, and vocabulary, plus custom commands if applicable. 
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The Upgrade Wizard, available from the Start screen under 
Dragon Tools, can automatically detect eligible profiles on your 
computer. Use its Remove button as needed so that only the 
desired profiles appear. 

If a profile you want to upgrade isn’t in the list (for example 
because it is on an external disk), use the Browse button to 
designate it. 

Once the list contains only the profile(s) you wish to upgrade now, 
click Next.  

 

 

IMPORTANT: After the upgrade completes, launch Accuracy Tuning to ensure that your profile can benefit 
from all your previous acoustic data. See the Audio menu and Help for details. 

 

Creating your profile—or adding an audio source  
This step-by-step process includes indicating your microphone’s type and verifying your sound system. 

Note:  

• If you already have a profile and just want to use another type of audio input device, add a source to your 
profile instead of creating a separate profile. (Details below.) 

• Consistency matters! For best results, create your profile in your “normal” environment, with the same 
background noise and equipment as you will usually have when using Dragon.  

• Unless you use a built-in microphone: Before you start Dragon, connect your microphone and, if you 
wish, test it by making a sample recording in Windows Sound Recorder. 

• For Bluetooth wireless headsets, see the Help and the manufacturer’s documentation. See how to charge 
your microphone, power it up, turn it on (put it in “call mode”), and ensure it is paired. 

Step 1: Launch Dragon (double-click its desktop icon or pick it from the Start menu). If Dragon has never been 
used before on this PC, the Profile Creation Wizard opens automatically; otherwise, choose New User 
Profile in the DragonBar’s Profile menu, then click New. 

Step 2: Answer the questions presented. The wizard will ask you to specify a “region” so Dragon can choose your 
profile’s underlying Auto-Formatting options and Vocabulary. For instance, this will affect whether Dragon 
uses the spelling “colour” instead of “color” and how it writes currencies or units such as lbs, $, USD and 
AUD (ISO codes).  

 

TIP: Once your profile is created, you are free to customize it, including modifying Auto-Formatting 
Options and Word Properties as described in this workbook and the Help.  
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Step 3: Indicate which type of audio source you are about to use. If you use a USB adapter on a standard 
headset, be sure to pick the USB option here. 

    

Note:  

• If your PC has only one audio socket (like on mobile phones), use a USB adapter or a Y-shaped 
adapter (“splitter”) with your regular microphone, or use a USB microphone. 

• If using a Bluetooth microphone, make sure it is not only powered up but also active. 

The Hardware Compatibility List on the Nuance website contains details such as the recommended 
settings for a particular model of microphone or recorder.  

About spoken recordings as source 
Dragon works with one voice at a time, so it cannot transcribe interviews or meetings directly. The 
transcription feature can be particularly useful to exploit what you dictate while observing something (such 
as during a field inspection) or after an event (such as after a meeting or a class). Once you have set up 
your profile for transcription use, you can use Dragon to transcribe your recordings. 

 

TIP: If your recording was “rough” or it contained voices other than yours, consider “re-speaking” rather 
than (or in addition to) transcribing the recording: while listening to the recording and pausing it as 
needed, you dictate to Dragon what you hear. Among other advantages, this gives you the opportunity to 
improve upon the original words, or add to them, including adding punctuation that hadn’t been spoken.  

 

Before recording files for Dragon to transcribe, note: 

• We recommend first using Dragon to dictate directly to your PC. This gives you a chance to 
practice speaking clearly, in long phrases, and with punctuation. From what you see Dragon 
transcribe as you dictate, you get feedback on how you are dictating. You also get ideas as to 
how to personalize the vocabulary, for instance by noticing jargon or phrases to add so that 
Dragon can write them with the spelling and capitalization you want.  

• Learn the essential operations of your recorder. Also, verify that the recorder is set to the correct 
time and date as well as optimal settings for speech recognition (see details on models tested by 
Nuance at http://support.nuance.com/compatibility). 

• Some devices come with software to manage recordings including converting their format. Check 
your device’s documentation.  

• Setting up a transcription source can be done using a sample of your own recorded voice, or 
someone else’s (you must have a profile for that person).  

Adding and managing sources 
If you already have a profile and want to use another type of audio input, add a source to your profile 
instead of creating a separate profile: open the Profile menu and choose “Manage Dictation Sources.” 
This opens the dialog box where you can pick the desired source. 

http://shop.nuance.com/store/nuanceus/en_US/pd/productID.205982000?resid=UCWoVAoBAlgAAFJizH4AAABA&rests=1344645204006
http://support.nuance.com/compatibility
http://support.nuance.com/compatibility
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Remember: personalizing the Vocabulary is one of the keys to getting Dragon’s full benefits! Having 
multiple sources within a profile means that, no matter which input device you use, the same Vocabulary 
will be used — and refined — each time you use Dragon. For example, the phrases and capitalization 
properties you taught Dragon while using the built-in array microphone as a source will also be available 
when you use a USB microphone, and vice versa.  

 

Step 4: Next is the microphone 
check. Read the boxed 
text in a clear voice, the 
way you plan to speak 
when working with 
Dragon. Here 
punctuation is 
recommended but not 
required. 

When Dragon lets you 
know it has heard 
enough, click Next.  

 

It’s best to read the text exactly as it is written. However, if you cannot read it, feel free to speak some 
sentences of your choice for about 30 seconds, in the same tone of voice you would use when dictating 
to your PC. 

Dragon then verifies that your sound system is acceptable for speech recognition.  

Note: Some computers offer several places to plug in your microphone. If you get poor results with one, 
consider the other (front or back, or for laptop users a docking station). Once you’ve identified which port 
works best, aim to always use that port for your microphone. (Considering marking it with tape.) 

Step 5: The wizard asks whether to have your profile participate in User Experience Collection, which helps 
improve Dragon by collecting usage data. This data will be analyzed by Research & Development to 
identify trends and help prioritize features. You can start or stop participating at any time by simply going 
to the Options dialog.  

After the last screen of profile creation, Dragon opens its Interactive Tutorial, short progressive simulations to help 
you discover and practice important aspects of Dragon usage. We recommend that all users take advantage of it.  

We also encourage you to explore Dragon’s options, including changing hot keys (particularly relevant to laptop 
users and people who use their numeric keypad for data entry). This workbook will progressively introduce you to 
options that most users should consider. Below are two of them. 

Important options 
After you create your profile, Dragon presents a message if it determined that your PC wouldn’t allow optimal 
performance. This informs you that Dragon has adjusted the defaults for two of its options:  

• The Speed versus Accuracy slider was moved toward speed. 

• The large sets of flexible commands for Microsoft Word, Excel, PowerPoint, and Corel WordPerfect were 
disabled (see the lesson “Controlling your Desktop and Applications”). 

Later, you can reverse these changes through the Options dialog, depending on your particular needs: you can 
enable or disable the Natural Language Commands for individual applications and experiment with the slider.  
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Note: Other options include having Dragon start in its sleep state (useful for persons who cannot use their hands), 
and disabling the “tracking” of menus, buttons and other interface elements or disabling the automatic Dictation 
Box where Dragon does not have Full Text Control (for example in PowerPoint).  

Turning off some options can make Dragon work faster on your PC. Examples include the ability to open items 
from the Start menu or desktop even when they are not visible, and the shortcut commands to create new emails 
or tasks. 

 

We recommend you take a look at the Help menu and begin personalizing the Vocabulary as soon 
as possible (this plays a crucial role in accuracy and efficiency).  

Note: If you’ve used a previous version of Dragon, we suggest you read What’s New in the Help.  
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Key points about getting started with Dragon 
 Each person who wants to use Dragon must have his or her own profile. Creating one is a short process 

guided by a series of screens.  

 Profiles from versions 13 and 14 can be upgraded to version 15. After upgrading, launch Accuracy 
Tuning from the Audio menu.  

 Make sure your microphone is properly connected and positioned, and the appropriate audio source is 
selected. See our website for details on special sources like recorders and wireless microphones. 

 You can add a source to an existing profile, for instance a USB microphone and your laptop’s built-in 
microphone. Whatever source is used, you will benefit from the same vocabulary and optional settings as 
well as custom commands, if applicable. 

 When reading text for the microphone check, speak clearly but naturally using the same volume, pitch 
and pace you are likely to use day-to-day.  

 Dragon's scheduled tasks are designed to help automatically improve accuracy. Schedule them for a 
time when your computer will be on but Dragon won’t be running. 
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Learning More and Getting Help 
Dragon offers so much that it would be impossible to cover it all in this workbook. This lesson presents ways to 
find more information as you start using the software—take advantage of them! 

Please see Dragon’s reference card, which includes important notes about installing Dragon as well as sample 
commands and how to dictate special characters, dates, and more. The latest printable documentation is 
available for download on the Nuance website. 

The Accuracy Center 
The most important features of Dragon are accessible directly from the DragonBar's menus. The Accuracy Center 
offers a central location to access all accuracy-related features.  

Step 1: Say Open Accuracy Center.  

Step 2:  Click the link that interests you or say its name immediately preceded by the word "click”.  

 

TIP: You can activate links without saying their whole name: for instance, instead of click import a list of 
words or phrases, you could say just click import a list. 

 

The Help 
The DragonBar’s Help menu gives you access to the on-screen Help topics (articles).Another way to open the 
Help is saying open help.  

When entering keywords in the search field, you can indicate phrases by putting quotation marks around them.  

To launch a Help search at any time, no matter what is active on your screen, you can use the shortcut command 
“search Help for…” with the word(s) to find. For instance, you could say “search Help for Internet Explorer 
commands”. The search keywords you name in this command will be considered individually unless you put 
them in quotes: for instance, “search Help for open-quote dictation box close-quote.”  

Dragon also provides contextual help: from its dialog boxes, a button or question-mark icon takes you directly to 
the relevant article in the Help. 

The What Can I Say command 

 

At any time, you can say what can I say, and Dragon will display a list of 5 commands applicable to the current 
application. You can then say any of those, omitting the word “show” if you wish. 
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Note: you could say the listed commands anytime, without first saying what can I say. Saying formatting 
commands, for instance, displays a short list of commands related to formatting text: 

  

The Interactive Tutorial 
Available from the Help menu, the Interactive Tutorial contains short progressive simulations and makes you 
practice important habits for efficient dictating, correcting, formatting and revising, using the Web, and 
customizing your Dragon profile including options and vocabulary.  

It includes important editing commands such as “go back,” Dictation Commands such as “cap,” “all caps,” and 
“numeral…” as well an example of correcting in the Spelling Window and accepting a Smart Format Rule. We 
recommend that all users take advantage of it. 

Note:  

• When the Interactive Tutorial opens, Dragon automatically turns off its microphone. Each simulation 
includes turning the microphone on and off, an important habit to develop.  

• While going through the simulations, you must speak just the current prompt and do so in one breath,  not 
pausing within it.  

The printable guides 
The latest Installation Guide is available as a PDF on the Nuance website alongside the reference card and 
other resources. The Help menu gives direct access to the website’s User Documentation page. 

When viewing the PDF file, you can click chapter headings to jump to specific topics, and you can print out 
sections as well as the entire file. 

Note: If you use a Bluetooth microphone, be sure to read its documentation, charge the headset, pair it if 
necessary, and make sure it is not only powered up but also active (that is, in “call mode”)—on the Plantronics 
Calisto, this is done by pressing the headset’s button.  
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Key points about learning more and getting help 
 This workbook is meant to get you started efficiently and cover essential concepts and tips. Other 

resources include the Help, the Accuracy Center, and the Nuance website. 

 Be sure to explore Dragon’s Help menu. You can open the Help at any time by saying a generic 
command such as open help, or “shortcut” commands that include keyword(s), such as search Help for 
Roman numerals. 

 At any time, you can bring up a short list of applicable commands by saying what can I say. This 
replaces the Sidebar feature of previous versions. 

Beyond these resources, consulting an experienced Dragon trainer for specific guidance and customizations can 
be particularly efficient for users who have special environments, workflows, equipment, or challenges (for 
instance, challenges related to motion, vision, or speech fluency.) 

Now let’s learn the most important aspects of using Dragon, starting with an often-overlooked but crucial one: 
personalizing your profile’s Vocabulary. 
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Why Personalizing the Vocabulary is Essential 
Transcribing a person’s speech presents acoustic challenges, such as accent and ambient noise. There is also a 
lexical challenge: for the transcription to be precisely accurate, familiarity with the terms used is necessary.  
For instance, even an experienced medical secretary would have trouble transcribing for an attorney’s office! And 
a newly-hired transcriptionist would have to not only get used to the voices of the various speakers, but also to 
learn what spellings and formatting they want, including acronyms, abbreviations, special phrases, names of 
people, places, products, etc.  

An unusual name may seem commonplace to you because you use it frequently, but a person who hears it for the 
first time may not be able to spell it: that name is not yet a part of this person’s vocabulary. Similarly, if a word or 
phrase is not in Dragon’s active vocabulary, the software cannot transcribe it correctly without a little instruction. 

When you created your User profile, you provided information which Dragon incorporated into its acoustic model.  
To get optimal accuracy, you should also help the software adapt its language model and Vocabulary. Lexical 
customization ensures that what you dictate is transcribed with the desired spelling, spacing, and even 
capitalization; Dragon provides many powerful tools for it, so this important investment need not take much time.  
The Help contains much information about personalizing the Vocabulary—including how you can even benefit 
from the customizations done by others.   

 

Key points about Vocabulary customization 
 As soon as you have created a profile, you can start dictating, but note that taking a moment to start 

customizing the Vocabulary is a good investment to make right away, since it helps Dragon “get it right 
the first time” (including capitalization) and it needn’t take much of time.  Personalizing the Vocabulary 
early and often is strongly recommended.  The following pages will show you how. 

 Dragon offers many simple and powerful Vocabulary tools to allow you to make your dictations faster and 
more convenient.  
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Customizing the Vocabulary—Using the Vocabulary Editor 
Dragon’s Vocabulary Editor lets you view what can be transcribed from the computer’s active memory; it also 
allows you to add new entries and edit existing entries—including their Spoken Forms and Properties. 

 

Let’s explore the Vocabulary Editor: 

Step 1: Say Edit Vocabulary (you can also use the Vocabulary menu or the Accuracy Center). The Vocabulary 
Editor opens; its scrollable window lists the entries currently in Dragon’s active Vocabulary.  

Take a moment to scroll through the list. You will see names of people, places, institutions and products, 
as well as common words, phrases, and abbreviations.  

Step 2: Open the Display drop-down list (located at the bottom) and choose Words Containing Spaces. Other 
Vocabulary displays include Words Containing Digits, Words Containing Capitalization, and Words with 
Special Properties. By browsing these, you can learn more about what the software uses to transcribe 
your dictation. You also get ideas about what entries you might add or edit. 

 

Adding vocabulary entries 
You can quickly search for a particular Vocabulary entry by entering it in the Search field. If it appears in the 
scrollable list, it is already in the active layer of the Vocabulary. If not, click Add to bring it in. 

CAUTION  When adding an entry to the Vocabulary, be sure to spell and capitalize it correctly! Otherwise, it will 
appear misspelled in your documents every time you dictate it. 
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Some of the "words" in the Vocabulary Editor aren't single words. Of course is listed. So is as well as. There are 
also names of people, places, products, and institutions: Mother Teresa, Madison Square Garden, KitchenAid, 
Brigham and Women's Hospital, Marine Corps, Library of Congress, Babe Ruth, Accounts Payable, George 
Washington, Johnson & Johnson, Division I, LAN Server…   

These help the software resolve spelling and capitalization ambiguities: if the Vocabulary didn’t contain the phrase 
Mother Teresa, dictating it would probably produce the transcription "mother Theresa"—because the word mother 
is usually not capitalized and Theresa is the more common spelling of the name. Having the phrase in its 
Vocabulary helps Dragon know that the words “Mother” and “Teresa” are likely to occur together, and hence helps 
Dragon choose the desired capitalization and spelling. 

Also, recognizing long sounds is easier than very short sounds. A and the are acoustically very similar, as are in 
and an. Longer words, like chrysanthemum, contain more acoustic information.  

We strongly recommend adding personal phrases; this will later save you time since you won’t have to adjust their 
spelling and capitalization after transcription.  

 

Exercise 1: In the Vocabulary Editor, search for names such as your first and last names, your town, company, 
colleagues or relatives, and if they are absent, add them.   

 

TIP:  When adding names of people, consider variants such as nicknames and diminutives as well as formal 
names, particularly for names that are very short or that can be spelled different ways: for instance, one might add 
Liz Jansen, Lizzie Jansen, Elizabeth McGee Jansen, Jennifer B. Wolff, Jennifer Wolff, Jenny Wolff, Jenn Wolff, 
Judge Wolff, Scooter Wolff… 

This applies to more than just names. Whenever you add an item to the Vocabulary, think of its possible 
variations: singular/plural for nouns, conjugated forms for verbs… Remember, if something is not in the 
Vocabulary, the software cannot recognize it, so don’t hesitate to add items even if you think you won’t dictate 
them often!  

 

 

Exercise 2: Open a word processor (such as DragonPad, available from the Tools menu or the command “open 
DragonPad”) and start a list of Vocabulary entries relevant to you. Below are suggestions. (Soon you will 
learn how to import these entries all at once.)  

• jargon and phrases specific to your profession (such as distro, site visit and non-State) 

• names of places, facilities or organizations (such as Building 6A, or County Adoption Center) 

• names of products (such as Latex Exterior Semi-Gloss)  

• acronyms, part numbers, codes (such as FICA, 501c(3) or RX-70y) 

• names of people (coworkers, clients, friends, relatives…) including combinations for names that 
could be spelled differently (Kristin, Gene, Steven, McGregor, Wolfe…) or are very short (Kip, Kit, Dee…) 
since this helps resolve acoustic ambiguities. 

 

TIP:  Consider obtaining lists such as personnel, departments, divisions, products, or trademarks, as well as 
glossaries of terms and acronyms. Starting from such lists doesn’t just save time; it may also help add these items 
with their official, correct spelling!  
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The importance of spoken forms 
Radio programs often tell their listeners “let us know how to pronounce your name” because some names could 
be pronounced in several ways and some are not pronounced “the way they are written” due to silent letters, for 
instance. This is true for more than just names. Acronyms are often pronounced letter by letter, but not always: 
ASAP is pronounced "ay sap" by many people. These facts are addressed by an important feature: the Spoken 
Form. 

From the Display drop-down list of the Vocabulary Editor, choose “Words with spoken forms only.” Take a 
moment to scroll through and look at existing spoken forms; you will get ideas for what kinds of entries warrant 
them and how they can be written. 

 

You may add spoken forms to custom entries as well as to existing entries, in order to be able to dictate them as 
comes naturally to you: for example, to enter the symbol ©, you might like to say “circle see” instead of the 
existing spoken form “copyright sign.” 
Note that entries containing symbols, digits, or unusual spacing are particularly likely to warrant a Spoken 
Form so that there is no doubt as to how the item will be pronounced.   

If you add e-mail addresses , giving them a Spoken Form can make them quicker to dictate: for instance, “Alex 
and John at yahoo dot com” or even just “Alex and John at yahoo” for AlexT&JohnB@yahoo.com. 
 
Note: Spoken forms must not include punctuation, abbreviations, or symbols. Below are a few examples. 
 

Written Form: The Man from U.N.C.L.E 
Spoken Form: the man from uncle 
 
Written Form: St. Clement's Hospital 
Spoken Form: Saint Clements Hospital 
 

mailto:AlexT&JohnB@yahoo.com
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Written Form: Soddy-Daisy, TN. 
Spoken Form: Soddy Daisy Tennessee 
 
Written Form: Trenton-Mercer Airport 
Spoken Form: Trenton Mercer Airport 

 

Adding Spoken Forms allows you to dictate in the way that is most natural, but also quickest for you. In addition 
to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic substitution: you say 
something short and easy, and Dragon types something longer or “trickier” to say (or to remember). This 
capability can be used to give consistency and clarity to your writings; groups can take advantage of it to help 
everyone comply with recommendations like avoiding abbreviations and other confusable items.  

 

Deleting “words” and modifying word properties 
If you encounter a word or phrase that Dragon does not transcribe as you would like, remember that it might 
warrant a spoken form or longer entry in the Vocabulary and Dragon may need to learn about how and how 
frequently you use it therefore you want to have Dragon analyze relevant text and run Accuracy Tuning (see the 
Accuracy Center). Also, particularly if the pronunciation contains non-English sounds, you may want to provide 
some acoustic “training”—see "Training Words".  

You may also run into cases where a word you need is consistently transcribed as another word. If that other 
word is not important to you, deleting it from your profile’s active Vocabulary will solve the conflict by removing 
your desired word’s “competition.” For instance: the names Schaeffer, Shaefer, Schaefer and Shafer all sound 
alike, so if you want Dragon to write “Schaefer” but it typically writes “Shafer” even though you have already 
corrected the error, you may want to delete “Shafer” from the Vocabulary. 

You can do this by finding and deleting the word in the Vocabulary Editor, or you can do it by bringing up the 
Correction menu over the undesired word after Dragon transcribed it. 

Note: Dragon’s active Vocabulary comes with literally thousands of entries. As you browse the Vocabulary Editor, 
you will see many you are very unlikely to ever about what you are dictate, but don’t spend time deleting them 
unless they actually cause a conflict! 

There’s more you can do in the Vocabulary Editor! For instance, by clicking its Properties button, you open the 
Word Properties dialog, where you can view or change the capitalization, spacing and numeral properties of an 
entry. 

 

IMPORTANT: Use the Word Properties dialog to modify the Dictation Command “new line” if you want it to 
trigger capitalization of the following word. Similarly, you can set the ellipsis (dot dot dot) to NOT trigger 
capitalization of the next word. 
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In the Word Properties dialog box, you 
can also choose one or even two 
alternate written forms. 

For example, you may want: 

the spelling “email” instead of the 
hyphenated “e-mail”,  

the abbreviation “fig.” instead of the 
word “figure” just before numbers, as 
in “fig. 3”,  

the title Professor instead of its 
abbreviation. 

 

 

 

Note: in the Vocabulary Editor, entries whose properties were modified are marked with a “P” icon. 
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Key points about the Vocabulary Editor and Properties 
 You can access the Vocabulary Editor with a command like edit vocabulary, through the Accuracy 

Center, or through the Vocabulary menu.  

 Custom-added entries are marked with a plus sign; choosing Custom Words Only from the Display 
drop-down list allows you to see just them. 

 You can locate an item by entering it in the Search field (enter either the Written form or the Spoken 
form). By using the drop-down list, you can also browse subsets like “Custom words only” and “Words 
containing punctuation.”   

 Spoken Forms are an efficient way to help Dragon transcribe “special words.” You can view many 
examples of Spoken Forms in the Vocabulary Editor. In addition to clarifying pronunciation (particularly 
useful for items that contain digits, symbols, or silent letters), Spoken Forms can be used to allow the 
speaker to say something quite different, shorter, or easier, than their written form: you say just “E O B 
stat”, for instance, and Dragon types “Explanation of Benefit (EOB) statement.”  

 If a Vocabulary entry you don’t need “competes” for recognition with something you do need to dictate, 
you can delete that entry from the Vocabulary Editor (for instance, Cassidy and Cassity). To see the 
words that have been deleted from the vocabulary, you can choose “Deleted words only” from the Display 
drop-down list. 

 You can view or change the special Properties of Vocabulary entries, including spacing and 
capitalization. For instance, you may wish to change whether Dragon uses the spelling “travelled” or 
“traveled”, whether the ellipsis (dot dot dot) and the Dictation Command “new line” trigger capitalization of 
the next word.  



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 18 

 

Importing Lists of Vocabulary Entries 
You now know how to add words and phrases one by one in the Vocabulary Editor. If you have many entries to 
add, this is not the most efficient method, particularly if you already have some relevant lists in electronic form. 
You can use the import feature to add many Vocabulary entries at once, even if they have Spoken Forms.  

Observe the sample import list in the illustration below, and identify the motivation behind each entry. You can 
then make and import one or more lists of your own, as described below. 

To create and import lists of “words”: 

Step 1: Create a document (or edit an existing document) listing entries you want to add to the Vocabulary. You 
can do it in any word processor as long as you can save this document as plain text. 

 
• Have each entry on a separate line.  
• Make sure everything is spelled, capitalized and spaced correctly. 
• To include a Spoken Form, follow the Written Form with a backslash character then the Spoken Form: 

for example, Grb II\grab two.  
 

 

 

Step 2: Save this document as a .txt file (from the File menu, choose Save As and, depending on the word 
processor, choose Text Document, Text Only, or Plain Text), then close the file. 

Repeat as necessary with other lists. (You may find it convenient to make several lists, such as a list of 
friends and relatives, a list of professional contacts, a list of product names, a list of local landmarks, etc.) 

Step 3: Say import custom words, or use the DragonBar’s Vocabulary menu to pick “Import list of words or 
phrases.” 
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Step 4: On the resulting dialog box, click 
the Add File button.  

The Add File window appears. Locate the 
file containing your list and click Open; the 
name of the file you designated is now 
displayed in the File List. 

If you have other lists to import, add their 
files in the same way. 

 

Step 5: Click Next. The software will 
import the listed items into the 
Vocabulary. 

 

 

The imported entries will be viewable in the Vocabulary Editor, where a red plus-sign appears next to them (like 
for entries that were added by means other than an import list). 

From the Vocabulary menu, you can also export all custom-added words into one file. This is useful for safe-
keeping or for import in other user profiles.  

Note:  

• You can choose .xml as an export format instead of .txt, so that Word Properties will be captured. 

• For files resulting from this export in Dragon version 11 or later, there are two items of note: the header 
@Version=Plato is added automatically, and spoken forms, if any, are separated by two backslashes 
instead of one. If you want to import such a file (as opposed to importing a file you made yourself), do not 
remove the header line and do not replace “\\” with “\”.  

• Exported word lists do not include trained pronunciations. 

 

Key points about importing Vocabulary lists: 
 You can add whole lists of Vocabulary entries at once. Prepare the list(s), then open Dragon’s list import 

dialog (you can say import words, or choose from the Accuracy Center or the Vocabulary menu). 

 Lists must be saved as plain text, and closed, before they can be imported. 

 Each entry must be on its own line. 

 To specify a spoken form in a word list, use a backslash (\) to separate it from the written form. 

 You can also export all custom-added words into one file (in .txt or .xml format). This is useful for safe-
keeping or for import in another profile. 
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Customizing the Vocabulary from Existing Documents 
You now know about importing lists of entries into the Vocabulary.  Another efficient way to boost your accuracy is 
to let Dragon analyze text that is similar to what you are likely to dictate: the tool Learn from specific documents 
can use many documents at once to “harvest” potential words to add to the Vocabulary, as well as to “adapt to the 
writing style” (i.e., learn frequency information).  The greater the amount of relevant text Dragon analyzes, the 
better Dragon can adapt its Vocabulary to what you usually dictate.  (This is similar to giving a just-hired 
transcriptionist documents in which to observe the terms used, their spellings, their context, etc.; doing so would 
help the transcriptionist get ready to transcribe your dictations most accurately.) 

The analysis tool supports Google Docs as well as files of the following types: .txt (plain text), .rtf (Rich Text), 
.doc(x) (Microsoft Word), .wpd (Corel WordPerfect), and HTML formats. 

 

TIP:  If significant text exists only in an application that doesn’t normally produce files of these types 
(PowerPoint is an example), see whether this application lets you copy text so you can paste it in the DragonPad 
and save it from there, or whether it offers a way to extract plain text (it could be called “export” or “save as 
outline” for instance.)  Also, if essential text only exists as PDF or in paper form, consider using Optical Character 
Recognition software such as OmniPage to convert into one of the accepted formats.   

 

Step 1: Locate some electronic documents you have written—think of reports, letters, memos, proposals... (As 
long as they are similar to what you intend to dictate, you can also use documents written by someone 
else.) The more closely these documents match the dictation you will usually be doing, the better.  

Step 2: Spell-check the documents if necessary (since Dragon would detect misspellings as unknown words.) In 
addition, remove any foreign-language sections that might be present. Then, make sure the documents 
are closed. The Help contains more details on this tool, including how to best prepare documents for 
analysis.  

Now that you have texts similar to your intended dictations, let’s designate them for analysis.  (If you 
obtain more documents later, you can designate them to Dragon at that time.) 

Step 3: Say "switch to DragonBar", "Vocabulary" then "learn from specific documents." 

 

Checking the box “Adapt to writing style” 
will make Dragon learn frequency 
information, which increases accuracy since 
it helps differentiate between homophones 
like “world” and “whirled”.   

Leave this box checked unless you only want 
to “harvest” potential custom words—for 
instance, if the text is very different from your 
normal style, or contains a foreign language.  

 

 

Step 4: On the Add Documents box, click Add Document. On the resulting window, locate and select the relevant 
document(s), then click Open.  
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Note: You can select multiple files 
at once by holding down the Ctrl 
key. You can also press Ctrl A, 
the Windows hot key for “select 
all.” 

 

 

Dragon now analyzes the text contained in the designated documents. This may take a moment—if there 
is a lot of text to analyze, you should run this tool when you do NOT need to use Dragon for something 
else. Once Dragon indicates that the analysis is complete, click Next.  

Dragon then presents you with a list of the “unknown” words it found, with a check box next to each one, 
and the number of times each word was encountered. The words found most frequently are at the top 
since they are most likely to be relevant, unlike those that only occurred a few times. 

Step 5: Adjust the list so that only the items you want to add are checked.  

Note: this list may include capitalized forms of common words (such as ‘Trainer’); these are usually better 
left out of the Vocabulary since you can always say “cap” before a word (or capitalize after the fact, 
thanks to “capitalize <xyz>”), but you may want to add to the vocabulary phrases that contain them, such 
as ‘Senior Technical Trainer’ (remember, it’s a good idea to add to the Vocabulary the phrases you 
usually want capitalized). 

Step 6: Edit items as warranted: if you wish to modify an item (to make it lowercase, or expand on it, for 
instance) or to give a spoken form to an item, make sure it’s highlighted then click Edit. 

This opens the Edit Word window, which also presents a little context for the item. 
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Once you click Next, Dragon gives you the option to provide acoustic training for the selected words. Feel free to 
take this opportunity to pronounce them, but know that you can skip this step and provide training later just for 
those words that seem to need it, as explained in this workbook and the Help. 

Finally, Dragon adapts its word-frequency and context information based on the text analyzed (unless you 
unchecked “Adapt to writing style” on the first screen); this will allow it to better choose between words that sound 
alike.  

 

Key points about customizing the Vocabulary from documents: 
 You can launch the analysis of specific documents from the Vocabulary menu. 

 This tool can analyze existing documents to learn about the “writing style” you plan to use—meaning, 
which words are used with what frequency, and which words appear near each other. It’s OK to use text 
written by someone else, if it’s similar to what you plan to dictate.  

 To be used in this tool, files must be text files. 

 The tool can process many files at a time. You can re-run it whenever you create or find suitable text. The 
more (relevant) text is analyzed, the more refined your profile becomes.  

 When presented with the unknown words the tool found, you can choose which ones to add. Thanks to 
the Edit button, you can modify their spelling as well as give them a Spoken Form if warranted. 

 After adding terms to the Vocabulary, letting Dragon analyze text that contains them helps pre-empt 
recognition errors.  

 Analyzing documents is only one of the ways Dragon can adapt; learn other ways in this workbook and 
the Help. 
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Customizing the Vocabulary from Your E-Mail  
As you learned, Dragon can adapt its Vocabulary based on designated documents. It also has the ability to 
quickly learn from your usage of e-mail. By “studying” the e-mails you sent as well as the recipient names, Dragon 
can identify potentially useful contact names to add to the Vocabulary, as well as adapt its statistical information 
on word usage (frequency and context). This will help it transcribe your dictations more accurately. 

You should take advantage of this tool as soon as possible after creating your User profile. (If you want Dragon to 
analyze Web-based email, make sure your computer is connected to the Internet for the duration of the analysis.) 

 

Step 1: Say open Accuracy Center, then say click Learn from sent e-mails. 

Step 2: The tool displays the names of available e-mail programs (this may take a moment). Check the checkbox 
of the program(s) you want Dragon to analyze. 

Note: If you want to use a Web-based email program that is not listed here, select the box labeled IMAP. 
You will then be asked to enter configuration information including server name and port number.  

Step 3: Use the checkboxes to indicate whether you want Dragon to only look for contact names to potentially 
add to the Vocabulary, or whether you also want Dragon to adapt its statistics based on your sent e-
mails.  

The option “Improve from my e-mail writing style” will adapt the statistical language model; it is 
recommended except if what you sent in that program contains a language other than the language of 
your profile. 

The analysis may keep Dragon busy for a while, especially the first time. Later on, it will go much faster if 
you choose the option button “Consider e-mail written since my last scan” instead of “Consider all e-mail.” 
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Note: When you start this process, your e-mail program may bring up a message box for you to allow 
Dragon to access it. If you have several windows open, this message may be hidden under another 
window.  

Step 4: After its analysis, the tool displays what it identified as potentially useful additions to the vocabulary.  

The rest of the process is similar to the analysis of specific documents: you can uncheck items 
individually or all at once, edit items, and train items acoustically if you wish, then Dragon adds to the 
Vocabulary the checked items -- plus it adapts its language model to the “writing style” (word frequencies 
and word sequences observed), if you opted for that. 
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Key points about customizing the Vocabulary from e-mail: 
 Dragon can quickly adapt its Vocabulary from your use of e-mail, including Outlook and Web-based email 

programs. If you want Dragon to analyze Web-based email, make sure your computer is connected to the 
Internet for the duration of the email analysis.  

 Use this as soon as possible after creating a profile, then every few weeks so that Dragon can adapt your 
profile as your work evolves. After the first time, the process will be very quick. 

 This process has two functions: it finds contact names to potentially add, and it analyzes your sent e-
mails to refine the frequency information in the Vocabulary . 

 When presented with the list of potential additions, you can check or uncheck them all at once. You can 
also edit any item: click the item, click Edit, then modify as needed. 

 Make sure Dragon knows the pronunciations and spelling of your contact names. This is important also 
for shortcut commands for Outlook such as “email the selection to…” and “schedule meeting with…”. . 
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Starting to Dictate: Controlling the Microphone 
Your microphone must be connected and positioned correctly, and Dragon needs to know whether to “listen.” This 
lesson shows ways to turn Dragon’s microphone or on off and introduces the DragonBar. 

Note: If using a Bluetooth microphone, make sure that it is not only powered up, but also active (that is, in “call 
mode”). See your microphone’s user guide for details. 

The DragonBar and the microphone icon  
The DragonBar is Dragon’s toolbar. It includes menus, indicators, and a microphone icon that you click to turn 
Dragon’s microphone on and off. The microphone icon is also available in the system tray on the Windows 
Taskbar.. 

 

By default, the DragonBar is docked to the top of the screen and collapsed. If you move your mouse over it, it 
expands. (If you wish to disable this auto-collapse, click the DragonBar menu.) Be sure to explore the Options 
dialog and the ways you can modify the DragonBar’s appearance to suit your preferences, including switching to 
the Classic DragonBar from version 12.  

If you’re familiar with Dragon and you wish to save space on your screen, set the DragonBar to Tray Icon only. 
(You can then display its content by right-clicking the icon or by saying   "open Dragon’s tray menu.”) 

See the Help for more information. Remember that you can quickly search the Help by saying a command that 
names search words, for example: “search Help for DragonBar display.”  

 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 27 

 

 

TIP: You may want to check that your operating system doesn’t hide Dragon’s tray icon. (The illustration below 
is from the Notification Area Icons section of the Control Panel in Windows 7.) 
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Microphone commands and sleep state  
You can turn off Dragon’s microphone by saying the command microphone off. There is no command to turn the 
microphone on because, when the microphone is off, it can't “hear” anything! There are, however, commands to 
put the microphone in and out of a “sleep” state where Dragon doesn’t transcribe your words but it is still listening. 
To try this, turn the microphone on by clicking on its icon, then say stop listening or go to sleep. 

 

IMPORTANT : For these and all voice commands, there should be a brief silence before and after, but 
none in the middle, otherwise Dragon can’t recognize the command and instead transcribes the words. For 
example, make sure you say the words “go to sleep” in a natural flow, not “go… to… sleep.”  

 

Putting the microphone to sleep is useful when you need to put Dragon “on hold" for a moment. However, leaving 
it in that state for a long time is not recommended, so do turn the microphone off if you won’t be dictating for a 
while and are physically able to turn on the microphone manually.  

Note: You can set Dragon to have its microphone asleep when your profile opens, waiting for your command to 
“wake up”, so that no manual action is needed to turn the microphone on. To set this option by voice, say “open 
Dragon options” then “click Miscellaneous” then “click Have the microphone on but asleep." 

The importance of hot keys, including Microphone On/Off 
Pressing a key or two is usually quicker than moving and clicking the mouse (and physically easier, too), so 
software programs, including operating systems, typically contain keyboard shortcuts, also called hot keys. 
Dragon provides hot keys for various useful tasks, including controlling its listening. 

If your computer has a full-sized keyboard, press the plus (+) key on the numeric keypad (on the far right of the 
keyboard). Pressing this hot key turns Dragon’s microphone on, and then pressing it again turns it off. 
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If your computer doesn’t have a numeric keypad, or you wish to keep the plus key for other use, designate a new 
key to serve as the microphone on/off hot key. This is done through Dragon’s Options dialog box: 

Step 1: On the DragonBar, click Tools, then Options (or say open options dialog). Click Hot Keys (or say click 
Hot Keys). 

Step 2: Click Microphone On/Off. A window entitled Set Hot 
Key appears. 

Step 3: Press the desired key or key combination, then press 
Enter. F10 is often a good choice.  

(If the key you pressed is already assigned in another 
application, Dragon will let you know.) 

Step 4: Back in the Options dialog box, click Apply, then OK.  

Note: Dragon also offers a hot key to toggle the microphone between sleep and listening. 

  

Key points about controlling whether Dragon “listens” 
 Remember to turn the microphone off (or put it into its sleep state) when you’re not dictating, such as 

before answering the phone, speaking to someone, or clearing your throat; this is a simple but important 
habit to develop!  

 Pressing its hot key is usually the fastest way to turn the microphone on and off; you can also click the 
microphone icon on the DragonBar or in the System Tray.  

 You can change any of the default hot keys in the Options dialog:.  

 You can turn the microphone off by saying the command microphone off, but then the mouse or 
keyboard need to be used to turn it back on. Instead, you could say go to sleep or stop listening and 
then say wake up or listen to me when you wish to dictate again. 

 For Dragon to recognize a command, you must pause slightly before and after but not in the middle of the 
command.  

 .  
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Starting to Dictate: Your First Dictation 
You can use Dragon to dictate into virtually any Windows application. Further in this workbook, you will learn how 
to start programs by voice (but one doesn’t need to have started a program by voice in order to dictate into it.) 

What you dictate will be inserted wherever your insertion point (cursor) is located in your document. There are 
many ways of moving the insertion point by voice, but know that you can also re-position it by hand (clicking the 
mouse where you want it, or using your keyboard’s arrow keys) just as you normally would. 

 

TIP Before dictating, make sure the desired window is active (its title bar should not be dimmed), and the 
insertion point (vertical bar) is where you want your dictation to appear. (Your operating system can make such 
visual elements easier to see.)  

 

Dictating text and punctuation marks 
Here are the most common punctuation marks, followed by what you say to “voice-type” them:  

. period (or full stop) 

, comma 

? question mark 

!   exclamation point or exclamation mark 

:   colon 

;   semi-colon 

For these exercises, start a word processor (for example, you can say start DragonPad). 

Exercise 1: Look at the following sample, dictate it, then say microphone off. (If any word is misrecognized, 
ignore it for now.) The very first words may take a moment to appear on the screen; this is normal. 

How is this different from dictating to a person? I should try to provide clean input: speaking naturally, 
but without mumbling or trailing off! 

Do turn off your microphone when you finish dictating! If your last sentence reads something like “trailing off! 
Microphone off", you probably forgot to pause briefly before giving the command. (If you cannot use your hands, 
say “go to sleep” or “stop listening” instead of “microphone off.”) 

New line and new paragraph 
With Dragon active, you can press your Enter key but also simply say the commands new line and new 
paragraph.  

Note: When you start dictating your new paragraph, Dragon will capitalize its first letter automatically, just like it 
automatically capitalizes after a period, an exclamation point, or a question mark. By default, Dragon doesn’t 
capitalize after new line or colon. 

 

TIP If you prefer new line to trigger capitalization, you can change its default via the Vocabulary Editor, since 
new line belongs to a special group of commands accessible there; these so-called Dictation Commands, such 
as cap, caps on and numeral, appear near the very top of the Vocabulary Editor’s list, with a blank Written Form 
field. To find them quickly, change the Display drop-down list to “Word with spoken forms only”. Once you’ve 
highlighted new line in the Vocabulary Editor, say or click Properties, then choose “capitalized” from the drop-
down list “Format the next word”. 
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The Results Display and its options 
Exercise 2: Study the following text sample then dictate it in a blank document. (Ignore any errors for now.) 

The more I use it, the software will adapt to the way I sound and the words I use. At the same time, I 
will also acquire good habits like pausing optimally, keeping silent when hesitating, and turning the 
microphone off, or putting it into its sleep state, when necessary! 

As you dictate, a small “rolling” Dragon icon appears, indicating that recognition is in progress.   

If the option “show preliminary results” is enabled (under Appearance in the Options dialog), you will instead see 
the following as in version 10 and prior: 

• Your words first appear in a small horizontal rectangle called the Results Box. Words accumulate in the 
Results Box until you pause, at which point they appear in your document. If many words are dictated 
without a pause, the box automatically stretches out. 

• The contents of the Results Box sometimes change as you speak; what first appears there may not be 
what is inserted in your document, since Dragon sometimes revises its original guess based on 
subsequent words.  

Dragon uses the everything it hears between two pauses to best choose what exactly it should transcribe; this is 
particularly important for words that can be spelled in different ways, like “to” and “too”. If you speak single words 
or just a few words at a time, the software has few or no contextual clues. For this reason, long continuous 
“utterances” can be recognized more accurately than short ones (and long words better than short ones).  

 

IMPORTANT : Try to formulate your sentences and commands before you start dictating them. This can be 
challenging at first, particularly for those who have been “thinking through their fingers” for years, but you’ll 
develop the habit once you see what a difference it makes. 

Note: Especially if you tend to forget punctuation, or if you are writing informally, consider Dragon’s option to 
automatically insert commas and periods as you dictate (see Auto-Formatting under the Tools menu). The Help 
contains details about this option and the commands to turn it on and off. 

The location and behavior of the Results indicator can be customized from the Options dialog. Many users find it 
most convenient to “anchor” the indicator to a place where it’s unlikely to hide anything, such as the bottom right 
corner of their screen; to do that, just check the “Anchor” checkbox, close the Options dialog, then drag the 
indicator to the desired place. 

 

Exercise 3: Dictate a paragraph of some four sentences on today’s weather. (For now, ignore any errors.) Did 
you forget to dictate punctuation in this paragraph? It can be harder to remember when we are “composing out 
loud” but, with practice, it will become second nature.  

 

Below are other frequent punctuation marks—you may want to say them out loud once before the next exercise. 
Note in particular the ellipsis and the difference between dash and hyphen.  

Remember that you can use the Vocabulary Editor to see punctuation and symbols with their existing spoken 
forms, as well as to add your own spoken forms, and to modify properties (such as “having no following space” 
like the open quote.) 

“ open quote 

” close quote 

… ellipsis or dot dot dot 

& ampersand or and sign 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 32 

 

( open paren or open parenthesis  

) close paren or close parenthesis 

--  dash 

- hyphen 

 

TIP: You don’t always have to say hyphens: thanks to its built-in Vocabulary, Dragon can automatically include 
hyphens in items such as 3-year-old, above-mentioned, after-tax, ad-libbed, ankle-length, anti-infective, as well as 
famous hyphenated names like Abdul-Jabbar. (To see many, you can choose “Words containing punctuation” in 
the Vocabulary Editor’s dropdown list “Display”.)  

You can prevent Dragon from entering a hyphen by pausing or saying “spacebar” where the hyphen would be. 

 

 

Exercise 4: Dictate the following sample. (If any recognition errors occur, ignore them for now.) 

These lessons remind me that "practice makes perfect." (Who said this, Confucius?)  

When it comes to speech-recognition software, truer words were never spoken… 

Note: At the moment one turns off its microphone off, Dragon may still be working on the last sounds it heard.  

 

 

Key points for your first dictation: 
 What you dictate is transcribed at the insertion point (the blinking vertical bar), the place where characters 

would appear if you started to type. Before you dictate, make sure that the desired window is not just 
visible, but also has the focus. 

  To modify how Dragon indicates that recognition is in progress, see the Options dialog under 
Appearance. To avoid situations where the Results indicator (icon or box) hides something on your 
screen, you can "anchor" the indicator. You can also change how long the indicator remains on the 
screen.  

 Speaking in long, continuous phrases provides contextual clues and thus helps Dragon choose between 
homophones like “right” and “write” or “to” and “two”. 

 Punctuation is part of the recognition context. Be sure to dictate at least periods and commas or turn on 
the automatic punctuation option.  

 Two important Dictation Commands are new paragraph  and new line. By default, new line doesn’t 
trigger capitalization of the following word; you can change that through the Vocabulary Editor’s 
Properties dialog. 

 The very first words you dictate may take a moment to appear on the screen. This is normal. 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 33 

 

Dictating Prices, Units, Dates, Times, Addresses…  
Dragon follows spacing and capitalization rules: for example, it inserts a space after commas but none before, 
and it capitalizes at the beginning of sentences and paragraphs.  

In this lesson, you learn about contextual automatic formatting that allows you to naturally dictate prices, times, 
dates, abbreviations, contractions, units of measure, street addresses, e-mail addresses, URLs, ISO currency 
codes and other special text. You also learn about Spell Mode and other recognition modes. 

 

Automatic text formatting during normal dictation 
On the Auto-Formatting Options dialog, available from the Tools menu, you can turn Dragon’s rules of auto-
formatting off and on as desired. For example, you can choose the following: 

- Transcribe numbers greater 
than two as numerals. (By 
default, Dragon follows the rule 
that small integers should be 
written as words unless in 
contexts such as a unit or 
address.) 

- Expand contractions (such as 
“won’t” and “didn’t”). 

- Insert two spaces after periods.  

 

The Vocabulary Editor’s Word 
Properties dialog offers related 
capabilities. It lets you obtain 
contextual formatting: you can ask that 
numerals always be used after a 
particular word (as in “version 4”) and 
you can set alternate written forms 
(for instance, if you prefer “figure” to be 
written “Fig.” before numbers, as in 
“Fig. 3”).  

Note: The Vocabulary Editor also lets 
you change the properties of Dictation 
Commands (for instance, you may wish 
“new line” to trigger capitalization, as 
“new paragraph” does).  

Please see Vocabulary Customization. 

 

 

Exercise 1: Dictate some phone numbers with and without area code. (No need to say "hyphen".) 

Please call 607-585-3926 instead of 587-1239.   Toll free directory: 1-800-555-1212  
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TIP By default, Dragon applies its automatic formatting rules even if you pause within the segment (the option 
“Allow pauses in formatted phrases” lets you turn this off.) If you need to dictate sequences of 7, 10 or 11 digits 
and do NOT want them formatted as phone numbers, one trick is to say “numeral” just before.  

 

Exercise 2: Dictate the following address. For the line containing the zip code, just say Oakland California 9 1 2 
3 5; Dragon automatically uses the postal abbreviation for the state and precedes it with a comma. 

127 Evergreen Terrace 

Oakland, CA 91235 

Exercise 3: Dictate the following dates. (Dragon automatically formats when you say, for instance, “Monday July 
sixteenth 2009”.  

 

TIP: You can change the default date format to one of those offered on the Auto-Formatting options dialog. 

 

Monday, July 16, 2009  10/15/09 (say slash)   12-7-2013 (say hyphen) 

Exercise 4: Dictate a few sentences containing prices, including the one here. (Say four dollars and ninety 
cents; Dragon will automatically format it with the dollar sign and dot.) 

Suggested retail price: $4.90 

Exercise 5: Dictate the following sentence, or a similar one containing a URL. Pronounce the URL w w w dot the 
best business dot com. Dragon will automatically remove the spaces between words.  

Please visit www.thebestbusiness.com for more information. 

Exercise 6: Dictate the following e-mail addresses. (Remember: for e-mail addresses you frequently dictate, 
adding them to your vocabulary will ensure that you can dictate them quickly and with high accuracy.)  

Laura_Miller@domain.com (say “Laura underscore Miller” and “at” or “at sign”) 

customerservice@electricalexperts.com (“customer service at sign electrical experts dot com”) 

 

The restricted Recognition Modes 
There may be times when you want Dragon to recognize less than it normally does. You may want to speak only 
commands, or enter many numbers or characters in a row—when inputting figures or product codes into a 
database, for instance.  

Take a moment to explore Dragon’s restricted recognition modes, which include Numbers Mode, Spell Mode, 
Command Mode and Dictation Mode. (Please see the Help for details beyond the ones below.) Note: Dragon 
includes a persistent indication of the current recognition mode on the DragonBar (next to the Full Text Control 
checkmark). 

 

TIP Dictation Mode can be helpful if you want to dictate as quickly as possible. 

 

http://www.thebestinthebusiness.com/
mailto:Laura_Miller@domain.com
mailto:customerservice@electricalexperts.com
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Numbers Mode  
When you are about to dictate a sequence of numeric data, consider switching to Numbers Mode. When in this 
mode, the software tries to recognize everything it hears as number-related (or as a command). 

Step 1: Say numbers mode on or choose Numbers Mode from the DragonBar’s Modes menu. (Notice the status 
message in the DragonBar.) 

Now that Dragon is in Numbers mode, you can: 
• dictate numbers and punctuation (hyphen, dollar sign…). For decimal point, say dot or point. 
• say new line, new paragraph and space  
• say go up|down|left|right <n> to move the focus to another line, cell, or item. 

Step 2: To resume regular dictation, you can say a command such as switch to normal mode, or use the Modes 
menu. 

Spell Mode  
The Spell Mode is useful for dictating character sequences which don’t form pronounceable words, as is often the 
case for part numbers, license plate numbers, codes, usernames and passwords… It’s also useful for spelling out 
terms which you anticipate Dragon won’t know, such as words in a foreign language or unusual product names. 
Of course, if you plan to use these words or phrases more than once, you should add them to the Vocabulary, 
with spoken form if warranted. 

Step 1: Say Spell Mode on or Switch to Spell Mode. The DragonBar will indicate that Spell Mode is on. 
You can now dictate characters, including letters, digits, and symbols, as well as spacebar.  

• To capitalize a letter, say cap immediately followed by the letter. 
• As in Numbers Mode, you can use the move <direction> <number> commands to navigate. You can 

also say space. (Dragon won’t automatically handle spacing as it usually does.)  
• You cannot use new line or new paragraph, but you can say press Enter. 

Step 2: You can return to normal dictating by voice (Spell Mode off…) or by hand (Modes menu> Normal Mode). 

 

TIP: The Help topic “Spelling Characters” contains the list of possible pronunciations, including the alpha-
bravo-charlie alphabet and accented characters like “n tilde” and “alpha umlaut”. When spelling out, you can also 
say “oh” instead of “zero”. 

 

The Spell Command: characters within Normal Mode 
If you need to dictate a sequence of characters in the middle of normal dictation, the Spell command is usually 
faster than switching in and out of Spell mode: while in Normal Mode, you can say “spell” immediately followed 
by a sequence of characters (digits, letters, symbols, and space or spacebar). See the Help for details. 

This can also be useful in cases where you want to put on the screen a word that would normally be interpreted 
as a symbol or a command. For instance, if you wanted to be sure that Dragon types the word “comma” instead of 
the character comma, you could say “spell space C O M M A”. This is also useful for the word “cap” which is also 
a Dictation Command (to trigger capitalization of the following word): say “spell space C A P.” 

 

Exercise 7: Dictate “access code: 75Zq/7”, then practice with character sequences of your choice. (Pause briefly 
after the colon, then say “spell 7 5 cap zee cue slash 7”. Try to not pause at all during the sequence; if you 
paused, just resume by saying “spell” immediately followed by the rest of your sequence.)  
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Key points about dictating numbers and special text 
 Dragon can format dates, times, prices, street addresses, phone numbers, Web addresses, units of 

measure, and other special text automatically. The Auto-Formatting options dialog (from the Tools 
menu) lets you turn these built-in rules off or on as desired. Also, the Word Properties dialog lets you 
adjust spacing, capitalization, abbreviations (such as Gen. for General) and other alternate written forms 
(such as “honour” and other spellings used in Canada). In version 13, Dragon reaches out to you through 
its Smart Format Rules box when it detects that you made a change that might warrant adjusting one of 
its format-related settings.  

 The restricted recognition modes can make dictating special text more efficient. They are accessible by 
voice commands (“Numbers Mode on”, “switch to Normal Mode”) and through the DragonBar’s Modes 
menu.  

 Dictation Mode can be helpful if you want to dictate as quickly as possible. 

 If you will be dictating only numbers and punctuation, consider turning Numbers Mode on. 

 If dictating a long sequence of characters (letters, digits, punctuation, symbols), consider Spell Mode. The 
Spell command is good for short sequences which you can say all at once, without pausing, such as 
“spell space T W O”. 

 When spelling out, you can use alternate pronunciations for the letters (such as alpha, bravo, etc.) and 
insert a capital letter by saying cap just before the letter. You can also say space or spacebar. (In Spell 
Mode, Dragon doesn’t handle spacing as it usually does.) 
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Correcting Dragon’s Errors in Your Dictated Text 
Human beings sometimes can’t recognize words correctly—especially if the speaker and the listener come from 
different regions, if the speaker is discussing an unfamiliar subject, or if the words are not well articulated. In 
addition, when we hear a word for the first time, we may not know how to spell it. Some people’s first or last 
names can be spelled different ways (like Gene/Jean, Hansen/Hanson).  

This is also true for Dragon! The software uses contextual clues and statistical information to guess what to 
transcribe, but sometimes cannot guess correctly. In particular, it may not recognize uncommon words on the first 
try, and instead types something that was likely according to its statistics. It cannot recognize and transcribe a 
word it has never seen. 

Fortunately, in addition to optimizing acoustic factors, taking advantage of the vocabulary customization tools and 
using proper correction techniques will significantly reduce the number of errors. Dragon’s Help contains many 
details about the different ways to perform it, including by keyboard. 

You can choose when to perform corrections. If you look at your screen while dictating and you notice that 
Dragon just got a word wrong, it's usually best to finish your train of thought before you correct that 
misrecognition: you may want to at least finish your paragraph. That being said, if the misrecognition affects a 
word which is likely to appear many times in your document, it's a good idea to correct it as soon as possible. 

Handling multiple matches in your text 
Dragon lets you directly address a specific word or phrase in your text. When you give a command such as 
correct <xyz> or delete <xyz> or capitalize <xyz> (<xyz> being the word or phrase to address) and Dragon 
finds several matches, Dragon places a number next to each match. 

You then say the number of the desired one. If you wish to affect all instances at once, say choose all. (If you 
want the numbers to disappear, say cancel, click your mouse, or just keep dictating.)  

Saying undo that undoes the change for just the last instance. To undo the change to all, say undo all. 

Note: choose all cannot work for “select” or for “insert before/after”. If you wish to replace several instances, you 
may want to explore your application’s capabilities for replacing, including specific capitalization. 

 

 

IMPORTANT: In Dragon’s commands, <xyz> represents the relevant segment on the screen (which could 
be more than one word and could include numbers or punctuation marks). When you give the ‘correct <xyz>’ 
command, be sure to say what is on the screen, not what you had intended. 
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It can be useful to provide context for the word(s) you intend to change: for instance, to correct "a" in the phrase 
"Alex sent a request," you may want to say “correct sent a” or "correct sent a request." 

The Correction Menu: the default interface 

By default, when you say a command starting with the word "correct,” Dragon brings up the Correction Menu, 
which lists alternative transcriptions as well as a few of the commands you may wish to say. In the example 
illustrated below, the speaker said “correct Madison.” 

• If what you had said is in the list, you can 
pick it by voice, saying choose and its number, 
or by hand (click the desired choice or use the 
down arrow and Enter key). 

 

• If it is not, you can click or say spell that 
which opens the Spelling Window. There, you 
can indicate the correct transcription using 
voice, keyboard, mouse, or a combination (see 
below). 

 

 

Note that the last item on the Correction menu gives you direct access to the Options dialog’s Correction section. 
(As seen on that tab, another default setting you can modify is Dragon’s opening the Correction menu also when 
you use the command select <xyz>.) 

Correcting in the Spelling Window 
Some users prefer the Spelling Window to be the default interface for correction, so they can act directly when 
Dragon’s choice list doesn’t show their desired transcription (instead of having to use “spell that” from the 
Correction menu to get to the Spelling Window).  

This requires changing one of Dragon’s Correction options. Here is one way to do this: say open Dragon options 
then say click Correct commands bring up Spelling Window (or click that check box). 
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With this option set, saying 
commands that start with 
“correct” opens the Spelling 
Window. So does using the 
Correction button on the Classic 
DragonBar, or pressing the 
Correction hot key (the numeric 
minus by default).  

 

As you will see, there are many 
ways to indicate in the Spelling 
Window what should have been 
recognized—including typing, or 
spelling out individual characters, 
hence the name “Spelling 
Window.” 

 

 

 

 

Here is an example. Imagine you wanted "Madyssen" (note the unusual spelling of this name) but Dragon wrote 
“medicine” (a word commonly used in English) instead of “Madyssen” (a relatively rare noun). To correct Dragon’s 
error, you can say “correct medicine”. The Spelling Window then opens. 
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At its top is what was transcribed, and below is a list of 
alternate transcriptions, each preceded by a number.  

 

Here is what you can do: 
 
If what Dragon should have transcribed is listed: 
say choose n (the number of the correct line—you can 
also pick by double-clicking or using the down arrow and 
Enter key). 
 
If no choice is quite correct but one is close:  
save time by modifying it instead of entering it yourself: 
click it, or say edit n (in our illustration, you could say 
“edit 1” then “backspace 4” then “Y S S E N”).  
 
If what Dragon should have transcribed is NOT listed: 
enter it then say click OK or press Enter (in our 
example, you could say “cap M A D Y S S E N”). 
 

 

 

 

The Spelling Window then closes and, in your text, Dragon replaces the misrecognized segment with what you 
indicated was the correct transcription.  

Note: In addition to adjusting your document, Dragon learned a bit of information to refine your profile, and if you 
entered in the Spelling Window a word that wasn’t in its active vocabulary, Dragon has now added that word to its 
active vocabulary (you could now see that word in the Vocabulary Editor). 

Remember that Dragon allows the use of voice but doesn’t prohibit manual action; at different times one may be 
quicker or easier than the other. In the edit line of the Spelling Window, it can be faster to make modifications with 
mouse or keyboard, but you can perform correction entirely by voice.  

You cannot dictate words in the Spelling Window. However, you can dictate:  
• Individual characters: letters, digits, space, symbols (see your documentation for details) 
• Commands like “backspace 5”, “move right 4 characters”, “delete next word”, “select line” 

Note: In the Spelling Window, Backspace and Delete commands should be used instead of scratch that, 
especially if Press Key commands are used. 
 
As you enter characters in the window, Dragon presents new choices in the list so you may not have to enter all 
characters! Here are tips for spelling out: 

• To spell a capital letter, just say cap followed by the letter. 
• You can use alternate pronunciations to spell letters: alpha, letter alpha, letter a, bravo, charlie, delta, 

echo, foxtrot, etc. (see the Help for the full list) 
• To insert a space, say space or spacebar. 
• If one of the choices listed is close, you can save time by modifying it: say modify and its number, which 

brings it to the window’s edit line . 
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Exercise 1: Look at the following sample, dictate it, then use the correct <xyz> command to fix any errors. (This 
sample was designed to create errors! All the names here could be spelled in different ways.)  

Until further notice, the BHDP meeting will be held in room B31 (not B40).  

Special invitees this week: Stephen Hess, Anne Petersen, and Gene Wood. 

 

TIP: If several consecutive words are incorrect, correct them together. For instance, if "B40” were recognized as 
"before tea,” you would say correct before tea. 

 

 

Exercise 2: Dictate a few sentences containing uncommon words, such as names and nicknames or product 
names, until a few misrecognitions appear. For each misrecognition, bring up the Spelling Window and practice 
spelling out what you actually said, as well as editing one of the choices from the list. 

Using playback to aid correction 
Sometimes, especially if you dictate a significant amount of text before correcting, you may not remember exactly 
what you actually said. Dragon’s playback feature is very helpful in these instances. You can take advantage of it 
in several ways. 

If you see that a certain word or phrase appears incorrectly, use the correct command to open the Spelling 
Window. Once it appears, click or say Play Back to hear the recording of your voice as you dictated that text. It 
may be that in fact you had misspoken or mumbled; this happens to everyone, particularly near the end of the 
day! In that case, close the Spelling Window (you can say click cancel) and dictate the word(s) again. 

 

TIP: You can have playback occur automatically with Correction. In the Options dialog, check Automatic 
Playback on Correction. This is particularly helpful as you first learn to use Dragon; you may want to turn it off 
after a few weeks of practice. 

 

You can also use Playback to hear sections of dictation in the document itself. To do this, select the editable text 
you would like to hear played back. Then, say play that back, or use the DragonBar’s Audio menu. If you find a 
misrecognition, you can stop playback by clicking the mouse (or using the Correction hotkey or button -- see 
below). Because speech input cannot be received during playback, you cannot stop playback by voice. If clicking 
the mouse is problematic for you, play small selections at a time. 

Note: You may wish to explore the Playback attributes in the Options dialog. 

If using the Classic DragonBar, expanding it (click its chevron or say view extras bar) gives access to several 
extras:  

 

• The Correction button opens the correction interface (as do the Correction commands and hot key).  

• The playback icons, similar to those on a music player, allow you to begin playback, speed up (useful for 
large sections of text) or stop playback, and skip backwards or forward. 
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• The Transcribe button launches the transcription of recorded dictations (for details, see the Help including 
the Auto-Transcribe Folder Agent). 

 

Exercise 3: Dictate a detailed paragraph about people you know. Then select it and play it back. If you find any 
misrecognitions, use the Correction button, hot key, or commands to correct them.  

Note: As you use Dragon more, experiment with how to correct and when to correct. (We recommend finishing at 
least your current paragraph before making a correction, so that you preserve your train of thought.) Notice what 
seems more convenient and efficient for you. 

Smart Format Rules 
When you make a correction related to formatting, such as abbreviations, titles, units of measure, or alternate 
forms, Dragon may display its Smart Format Rules box, offering to change one of its Auto-Formatting options or 
Word Properties settings. You can then either accept one of the adjustments offered, or dismiss the box. 

If you wish to, you can change settings yourself from the Auto-Formatting Options dialog box or the Vocabulary 
Editor, as in previous versions. The Smart Format Rules feature simply "reaches out" to you, making it quick and 
easy for you to adjust the settings you care about. 

For example: When you dictate “five kilograms,” Dragon writes “5 kg” and if you then change “kilograms” to “kg” 
(by overtyping, or using the Correction menu or Spelling window) Dragon presents the Smart Format Rules box 
pictured here. 

 

Take a moment to read what the box offers. Then, if you want one of the proposed adjustments to be made, say 
“choose” followed by the desired number.  

If you don’t want any of the choices proposed, you can say “cancel” or just move on to whatever you would have 
done if the box had not come up. 
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Key points about correcting recognition errors 
Refining your profile can prevent many errors, because it helps Dragon learn how you sound and what words and 
phrases you use often. Add words and phrases to the Vocabulary, with Spoken Forms and/or Properties if 
warranted and be sure to let Dragon see your words and phrases in context, for instance by letting it analyze 
relevant documents. 
Although correcting misrecognitions may seem time-consuming at first, it will result in increased accuracy, which 
in turn means that there will be fewer and fewer misrecognitions to address.  
To have the Spelling window as the default correction interface, enable the option "Correct" Commands Bring 
Up Spelling Window.  
Flow is important: commands require a brief pause before and after. Do not pause at all between the word 
‘correct’ and the misrecognized word(s). At first, you may want to “rehearse” the whole command in your head 
before speaking it. 
When the Spelling Window is open, you can say choose n to pick from its list. If no choice is exact but one is 
close, you can quickly modify it: click it or say edit and its number (for instance edit 5). This brings it to the top, 
where you can edit it by hand or by voice. 
You can use the Spelling window to type or spell out words, but not to dictate words directly. 
To be sure of what was said for the text segment you are correcting, use Playback. Another advantage of 
playback: it gives you feedback on how clearly you dictated. 
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Editing Text by Voice 
Dragon lets you use your voice to move around within a document and edit the contents—whether or not that 
document was originally created by voice. As you learned, the software transcribes your dictation wherever the 
insertion point is. (The insertion point is usually shown as a blinking vertical bar some call the cursor.) 

This lesson presents some of the commands to select text and move the insertion point. Mouse and keyboard can 
still be used, of course. Don’t try to do everything by voice unless you have to. At first, focus on getting optimal 
accuracy in your dictations — speaking clearly, adapting the vocabulary, performing corrections as needed, 
reading a text for acoustic training…  

 

Navigation and selection  
Note: Navigation commands use the words go and move interchangeably, and a space counts as one character. 
 
Some commands move the insertion point regardless of its starting location: 

move to top, or go to start of document –- moves to the beginning of the document 

move to bottom –- moves to the end of the document 

 
Other commands move the insertion point relative to its present location: 

         move to end of line (the current line, the one containing the insertion point) 

move up(down) 1-20 line(s) or paragraph(s) –- e.g. move up 3 lines  

move left(back) 1-20 word(s) or character(s) –- e.g. move left 7 words 

move right(forward) 1-20 word(s) or character(s) –- e.g. move forward 3 characters 
 
The insert before/after commands position the insertion point just before or after a specific word or punctuation 
mark in the text: 

insert before your office –- moves the insertion point to just before the phrase "your office" 

insert after Joe comma -– moves to just after the comma following the word “Joe” 

 

The select commands let you designate editable text visible on the screen. Below are just some of them.  
You can say select followed by what you wish to highlight (include punctuation as needed): 

select let me know select comma obviously comma 

  
For longer phrases, you can specify a range by naming its beginning and ending word(s): 

select do let THROUGH please – "do let me know at your earliest convenience please" 

 
You can select one or more characters, words, lines or paragraphs at a time: select line, select next 3 
paragraphs, select previous 5 words, select next character… as well as select rest of line. Note: You can 
use similar commands to delete (delete line, delete next three words…) and copy (copy line, copy rest of 
line…) 
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You can also select the entire content of the field or document with the command select all. 
 
Note: You can “unselect” a selection by saying unselect that. Another way is to move the insertion point with a 
move right command, for instance.  

 

TIP: Say commands as a continuous phrase, with a brief pause before and after. For commands that quote 
words from your screen, choose your target words before you start to say the command. Otherwise, any 
hesitation will cause the words of the command to be typed on the screen. (If this happens, just say scratch that 
and give your command again, without pausing this. 
 
One should always strive to dictate in complete phrases, since context helps the recognition of text. When it 
comes to commands, formulating the whole phrase and dictating it without pauses isn’t just helpful, it’s essential. 
The exercises below will provide plenty of practice.  

 

Handling multiple matches in text  
When you give a command that quotes from your text(such as “insert before <xyz>” or “bold <xyz>”) and Dragon 
finds multiple matches for <xyz> (including homophones), Dragon lets you resolve that ambiguity and even take 
advantage of it. A number will appear next to each visible match. You can then: 

• say the number of the desired instance, or  

• say “choose all” (for commands that can apply it)  

 

  

Direct editing: Bold | Underline | Capitalize | Copy | Delete | Cut…  
Dragon lets you perform frequent editing tasks quickly: like you can quote from editable text in the commands 
select <xyz> and select <start> thru <end>, you can say the verbs bold, underline, italicize as well as 
capitalize, immediately followed by the desired word(s). This also applies to copy, as well as delete and cut—
note that these three can be disabled, as explained below. 

Note: If these commands are enabled, Dragon will try to recognize as one of them any phrase starting with one of 
these verbs followed by a word or phrase present in the text: e.g. “bold measures” or “cut corners.” Because  
Dragon recognizes commands only if they are spoken as one flow between two pauses, this could happen if the 
phrase is said in isolation—for instance, if the speaker is creating a list or had just hesitated (as one often does 
when composing out loud). If this happens, say undo that. 

Remember in particular the possibility of unintended recognition of cut <xyz> and delete <xyz>, especially if you 
dictate without looking at the screen. If you prefer to avoid this risk, disable these commands: clear their checkbox 
in the Options dialog. 
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Full Text Control, “unknown” text fields and the Dictation Box 
Commands such as ‘correct <xyz>’ and ‘insert after <xyz>’ (where <xyz> is a word or phrase in your text) work 
thanks to a Dragon functionality called Full Text Control or enhanced dictation and editing (formerly “Select-and-
Say”). This functionality requires the text field to let Dragon be aware of its content, such as where words and 
sentences begin and end. It also encompasses Dragon’s ability to automatically capitalize the first word, adjust 
spacing after an insertion, and play back dictation. 

Many popular applications build their text fields (or at least most of their fields) in a standard way, and as a result 
Dragon has Full Text Control in these fields.  

However, you may encounter a field for which Dragon can’t have that awareness—and therefore Dragon can’t 
always apply all its normal capabilities. PowerPoint slides are one example. If you just dictate a flow of words, you 
may not notice anything unusual, especially if you start with a word that is always capitalized such as a name or 
the pronoun “I”.  

When the insertion point is in such an “unknown” field, the DragonBar’s Full Text Control indicator is dimmed. 

Even in “unknown” text fields, one can use Dragon efficiently—knowing the following: 
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1. To dictate short entries, you may want to just use what does work in all text fields—dictate normally and, if 
and when necessary, do the following: 

- say ‘spacebar’ (or press the spacebar),  

- say ‘cap’ before a word to force its capitalization,  

- say generic commands like ‘select line’, ‘undo that’, ‘go to top’ and ‘move <left | right | up | 
down>’ or reposition the insertion point by hand, etc. 

2. To dictate something substantial, consider using the Dictation Box, an intermediary window in which you can 
create, modify, and correct text. When your  text is ready, use the Transfer button (say ‘click transfer’): 
Dragon then closes the box and transfers your text to where you had the insertion point. 

 

 

To open the Dictation Box, you can: 

• Use its hot key: Ctrl+Shift+d 

• Say a command such as ‘Open 
Dictation Box’  

• Use the Tools menu 

 

 

The box comes up automatically if you speak where Dragon doesn’t have Full Text Control (except in Web 
browsers). This default can be changed in the Options dialog, under Miscellaneous. 

There is a lot of flexibility around the Dictation Box. In addition to changing its hot key, you can: 

• Give its command one or more alternate names, if you prefer to open it by saying ‘open Dragon box’ for 
instance(to find the command in the Command Browser:, you can filter for the word ‘box’ with ‘Global 
Commands’ selected in the Context list). 

• Modify its appearance and behavior: default font size, positioning (anchored or near the cursor), copy and 
paste method, whether it shows how many characters it contains… 

• Have different settings for different applications. See the Help for details. 
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Replacing and inserting  
The select and correct commands are useful when you wish to change some of the text on your screen. As you 
would with mouse or keyboard, you select the relevant segment then you overwrite it by dictating or typing.  

For instance, if your text reads "100 Main Street" but you wish to change it to "500 Washington Street", say select 
100 Main (pause) 500 Washington.  

 

TIP: For larger passages, save time by using select line, select <start> through <end>, select paragraph… 
Note also that the command “resume with…” can be very efficient as an equivalent of selecting what you just 
dictated up to a particular word then deleting that segment and resume dictation; be sure to read about it in the 
Help and try it out. 

 

Exercise 1: Practice “overwriting” by voice. Examine then dictate the following paragraph. 

I will be in the Boston area for a few days the week after next, and would love to get together for lunch. 
We could meet at your office at noon. I’ll be staying at the Madison downtown.  
Talk to you soon! 

1) Say select lunch  The word “lunch” is now selected. 

Say an early dinner  The sentence should now read “get together for an early dinner.” 

2) Say select noon 
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Say six o’clock  The sentence should now read “We could meet at your office at 6:00.” 

3) Say select in through next  The segment “in the Boston area for a few days the week after next” is 
highlighted. 

Say in your area on Tuesday July fifteenth  

Let’s say we now want to add a few words inside this paragraph.  

4) Notice the insertion point’s current position. Say insert after dinner, then say if you have time. 

5) Say insert before exclamation mark (observe the move), then say comma I hope.  

 

TIP: If, after doing some editing in your text, you need to remove trailing white space, you can use commands 
such as backspace or delete next character for a single space. You can even say backspace combined with a 
number: for example, backspace 5 is like pressing the backspace key 5 times. 

 

 

Dragon can help you quickly edit text whether or not this text was created by voice. The exercise below is to be 
performed entirely by voice, but remember that for optimal productivity in daily work you may use a combination of 
voice and keyboard/mouse. 

Exercise 2: Look at the following text, dictate it, then edit it by voice as described below.  

Dear Ms. Cooper, 

It was nice meeting you Tuesday. I think you have some good ideas about the Johnson project! Let’s get the team 
focused on this project by February.  

When you have time, could you write up your comments and email them to me? I would really appreciate it. 

• Edit the first sentence so it reads "meeting with you last Tuesday". 

• Edit the second sentence so it reads "You have some great ideas". 

• Edit the third sentence so it reads "on this important project". 

• Edit the third sentence so it reads "by early February", and insert a blank line after it. 

• Change the fourth sentence to “Could you please write up your notes and email them to me ASAP?” 

• Edit the salutation, changing "Ms. Cooper" to "Allison". 

• Edit the last sentence, removing "really", and add a closing line of "Sincerely, Debra Peet-Smith". 

Which commands did you find most useful in each situation? 
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Key points about editing text 
 You can use Dragon to edit a document by voice whether the document was dictated or typed. 

 Dragon’s many editing commands can address small or large amounts of text, even several paragraphs 
or the entire document (select paragraph, select all). 

 At first, uttering the whole command can be tricky for commands that quote words from your text, such as 
select… through… and insert before <xyz>. As usual, deciding what you are going to say before 
starting to speak is recommended. If you paused mid-command, just say scratch that, pause, and give 
the complete command again. 

 Commands that quote your text (bold <xyz>, correct <xyz>, insert after <xyz>, capitalize <xyz>…) 
work thanks to a functionality called Full Text Control, which depends on Dragon’s ability to constantly 
obtain information such as where words and sentences begin, so Dragon can adjust spacing between 
words and capitalize the beginning of a sentence.  

 If dictating in a non-standard field, remember that you can say Cap to start a sentence and spacebar to 
create a space, as well as use the Dictation Box—an intermediary window which has Full Text Control.  

 In Dragon 15, the Dictation box opens automatically where Dragon doesn’t have Full Text Control (except 
in Web browsers). You can disable this in the Options dialog. 

 You can modify the Dictation Box’s appearance and behavior; in addition, you can modify its hot key and 
give its command one or more alternate names. 

 You can set the Dictation Box to behave differently for different applications.  



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 51 

 

Formatting Text by Voice 
Whether text was originally dictated or typed, Dragon lets you use your voice to control font (Arial, Courier…), font 
style (bold, underline…), font size, alignment, color, and more. 

Note: In order to preserve your train of thought, it’s a good idea to prioritize dictation over formatting: first dictate 
your document (or at least finish dictating your paragraph, list, or idea), then revise your words if needed, and only 
then apply formatting. 

The "X that" convention 
Dragon has many commands to tell the computer to perform a certain action on a certain item. Many are phrased 
as "X that", with X being a verb for the desired action: for instance, italicize that and delete that. 

Remember, for commands to be recognized, you must pause before and after the command but not within it.  

When Dragon hears an "X that" command, it decides what “that” is as follows: 

1) If anything on the screen is highlighted (whether by voice or by hand), Dragon performs the action on that 
selection. (It can be one or more characters or words.) 

2) If nothing is highlighted, Dragon performs the action on whatever you dictated since you last paused—in 
n other words, the contents of the Results box, the last utterance. 

Note: In commands, you can say “the selection” instead of “that”—as well as “it” or “this.” 

 

Dragon's "X that" editing commands include: 

cap that – capitalizes the first letter of words, e.g. Water Management  

 (Dragon also has “capitalize <xyz>” as seen in the section on direct editing commands) 

all caps that – capitalizes all letters, e.g. EXTREMELY IMPORTANT 

no caps that – puts in lowercase all words, e.g. american express 

delete that (Dragon also has “delete <xyz>” as seen in the section on direct editing)  

TIP To delete your few last utterances, you can repeat scratch that or specify a number of times (for 
instance, scratch that 5 times) but the command “resume with…” can be most efficient. 

bold that, italicize that, underline that (Dragon also has “<verb> <xyz>”) 

restore that – removes all bold/italics/underline formatting from the segment 

left-align that, right-align that, center that, justify that  

copy that and cut that (you can also use the direct editing commands “<verb> <xyz>”) 

paste that 

hyphenate that – puts hyphens in the spaces within the segment  

compound that – removes spaces between words in the segment 

bullet/unbullet that  

quote that – puts quotation marks around the selection or last utterance 

bracket that (inserts rounded characters, not square brackets, if your profile is set to UK English) 
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empty quotes or empty brackets –inserts a pair of quotation marks or brackets so you can dictate 
between them. 

 

TIP: The Command Browser’s Keyword Filter lets you explore additional command wordings for the applications 
you frequently use, as seen in this screenshot. For instance, in Word and WordPerfect, you can say “turn bullets 
on” and “turn bullets off” as well as “format that bulleted and bold.” 

 

 

The "Format That" commands 
Not all formatting commands are worded as "X that", but all follow the same rules about what text the action is 
performed on: the selection if there is one, otherwise the last utterance (what was said since the last pause.) 

As seen in the Command Browser, the many formatting commands include: 

format that bullet style (also: bullet that or make that bullet style) 

format that numbered 

format that centered 

format that strikeout –- places a line through the selection (for example, January 19) 

format that regular 
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Note that formatting commands can combine several indications, as in: 

format that Garamond, format that Arial 13, etc. –- gives the selection the font name/size specified 

format that 20 point, format that 13 point, etc. –- gives the selection to the point size specified 

format that bold italics  

format that caps bold 

format that bulleted and plain 

 

Exercise: Dictate the following to experiment with giving format commands as you dictate and afterwards.  

I FINALLY read The Grapes of Wrath. Although it is long, I read it surprisingly quickly. 

 

TIP To undo the last action, say undo that. This is equivalent to the keyboard shortcut Ctrl z. 
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Key points about formatting documents 
 The “X that” commands apply to the current selection or, if there is no selection, to the last utterance 

(what Dragon heard since you last paused).  

 Remember to pause briefly before and after saying a command. 

 You can repeat delete that or scratch that up to 10 times to delete the last things you said—you can 
also say scratch that 3 times, scratch that 7 times… For deleting from the end of your dictation back to 
a particular word, the command resume with… can be very efficient; we strongly recommend it. 

 To undo the last action, you can say undo that (which is equivalent to press control z).  

 For efficiency, prioritize dictation over formatting: first finish capturing your thought, then revise or correct 
the text if needed, and only then apply formatting. 
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Controlling the Operating System and Applications  
Dragon can do much more than type and format your dictated text: it lets you use your voice to find information, 
open a specific website, start programs, open desktop items, switch between windows, maximize windows, 
choose menu items, navigate dialog boxes, click buttons, press keys, move or drag the mouse pointer, etc.  

 

IMPORTANT: When Dragon is running, it doesn’t inhibit the use of your mouse and keyboard. Mouse, 
keyboard, and voice are three input options; use whatever is fastest and easiest for you for a given task. 

 

Searching the computer  
Dragon has shortcut commands to speed up a process many of us go through often: finding information that is 
somewhere on our computer!  

At any time, no matter what application is currently active on your screen, these commands let you launch a 
search for items containing the keyword(s) you specify.  

They have flexible wordings (the Command Browser lets you see all the possible ways to say them) and can be 
general or specific, as follows: 

• search computer for <xyz>, <xyz> being any word or words  

• search emails for <xyz>: searches  just the e-mails indexed on your computer 

• search documents for <xyz>: searches just the indexed files 

• search history for <xyz>: searches just the indexed Web pages visited 

Note: The Desktop search shortcuts can be disabled or enabled in the Options dialog, where the box “Enable 
Desktop search shortcuts” also controls the Help search shortcut (search Help for…). 

 

Controlling programs and windows 

You can use your voice to open any item present on the Desktop, including files, folders, and shortcuts: just say 
open followed by the item’s name. (You can also use the verbs start, launch or show.) For instance, to open an 
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item called “winter projects”, you could say open winter projects. (It’s helpful to use names that are easy to 
speak!)  

This works at any time, even if the desktop is not visible. This is a powerful feature but if you don’t need it, 
consider disabling it; see under Commands in the Options dialog. 

Dragon has a similar option for Start items: at any time, you can start by name any program or item present in the 
Start menu, saying open Internet Explorer or open Control Panel. Consider disabling this powerful feature if 
you don’t need it.  

 

TIP: Do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2013"? In the Start 
Menu, look under Programs. The name listed there is what you usually want; for popular applications, shorter 
names are supported. If you find the listed name inconvenient, you can create a shortcut to the application and 
rename that shortcut to something easy. 

 

To open the Start menu, say click Start or click Start menu.  

To close the active window, say close window or press F4. 

Resizing and switching  
To minimize the window in focus, say minimize window. To maximize, say maximize window. 

If several windows are open, you can change which one is active and in the foreground in several ways: 

• Say “switch to” followed immediately by the name of the desired application, folder, or document: 
switch to Outlook, switch to Computer, switch to DragonBar, switch to winter projects. 

• Say switch to next window to cycle through the open windows (this is equivalent to Alt Tab). 

• Say list all windows then say (or press) the number of the desired window. Note: you may wish to 
specify an application, saying for instance list windows for Dragon or list windows for Internet 
Explorer. 
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“Clicking” menus, buttons and other controls 
To "click" on an application menu, just say its label preceded by the word “click” (or not—see below). For 
instance, for a menu labeled Insert, say click Insert. (The application must have the focus, which you can usually 
tell by the appearance of its title bar.)  

When accessing a submenu, pause briefly after the name of the menu. For instance, to save a file under a certain 
name, you could say click File, then say save as. 

 

TIP: To close an open menu, you can just say cancel or press Escape (equivalent to pressing the Esc key at 
the top left of your keyboard). 

 

Note: With Office 2010, Microsoft introduced changes to the application interface—in particular, the File tab. For 
this tab, you must say “file tab” not just “file.” With Office 2013, Microsoft also made some interface modifications. 
For details, see the Help. (Remember that you can quickly launch a search in Dragon’s Help by naming search 
keywords in a command such as “search help for office 2013.”) 

In addition to menus, program interfaces may contain controls such as buttons, checkboxes, and radio buttons. 
How do you access these by voice? You guessed it: “say what you see” preceded by “click” if required. Please 
note: 

• Dragon lets you require the word “click” before the names of menus independently from buttons and other 
interface controls. 

• By default, Dragon requires the word ‘click’ before the name of menus as well as buttons and other controls: 
for instance, for a button labeled OK, you would say click OK. (This can be useful to prevent unintended 
actions such as the clicking of Send in email.) Dragon offers a similar “Require ‘Click’” option for HTML links, 
which applies to links in supported Web browsers, Help, and Accuracy Center. See the Commands page of 
the Options dialog. 
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This workbook presents several of Dragon’s dialog boxes, which often contain controls labeled Cancel, Yes, or 
OK. As you perform the exercises in each chapter, consider practicing clicking controls by voice.  

Exercise 1: Previous lessons introduced you to the Options dialog; we will use this dialog box to practice 
accessing buttons, tabs, and other interface controls. 

1. Open Dragon’s Options dialog, then its Appearance page.  

2. Select and unselect the radio buttons and checkboxes for the DragonBar. 

3. Restore the defaults. 

 

IMPORTANT : Dragon lets you disable its ability to “track” the name of interface controls, in all programs or 
just in programs of your choice: see the checkbox and drop-down list “Voice-enable menus, buttons and other 
controls” on in the Options dialog under Miscellaneous. 

 

Natural Language Commands and the Command Browser 

Dragon comes with large sets of commands that let you order actions directly and in a natural manner, instead of 
going through menus, submenus, and dialog boxes: for instance, saying “insert page break” in Microsoft Word 
instead of opening the Insert menu, then choosing Page Break. 

As you will notice, command names tend to describe the desired action, starting with the verb.  

• To read about the commands for a specific application, say open help or launch a Help search on 
keywords with a command such as “search Help for Internet Explorer commands.”  

• To see all the commands and their variations (optional words, alternate words, etc.), open the Command 
Browser and use its Context list and Keyword Filter to display just the commands that contain a particular 
word and are active in a particular application. When you see a command that looks interesting, make 
sure it’s highlighted then use the Command Browser’s menu to show all its wordings (for instance, to 
include all optional words or expand ellipses). 

 

IMPORTANT: If it detected that your PC’s resources would not allow it to perform with both maximum speed 
and accuracy, Dragon may have disabled its Natural Language Command sets for Word, Excel, PowerPoint and 
WordPerfect. If speed is not a priority for you and you wish to use Natural Language Commands in one or all of 
these applications, enable them via the Option dialog. 

Note that if you enable the Natural Language Commands for Word, for instance, Dragon’s speed may decrease 
within Word. 

 

“Voice-pressing” keys 
At times, you may wish to use your voice to press a key or key combination on your keyboard. 

Common accelerator keys for Windows operating systems include: Esc to close a window, Enter to active the 
item which has the focus, Tab to move the focus forward, and Shift Tab to move the focus backward. Most 
buttons, menus and checkboxes have an underlined letter in their label: you can activate them by pressing the 

mk:@MSITStore:C:%5CPROGRA%7E1%5CNuance%5CNATURA%7E2%5Chelp%5Cenx%5Cpower%5Cdragon_enx.chm::/cmd_browser/open_command_browser.htm
mk:@MSITStore:C:%5CPROGRA%7E1%5CNuance%5CNATURA%7E2%5Chelp%5Cenx%5Cpower%5Cdragon_enx.chm::/cmd_browser/open_command_browser.htm
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underlined letter (if underlines are not visible, press Alt first.) For keyboard shortcuts specific to a particular 
application, search the application’s Help or the Internet. 

Dragon lets you “voice-type” keys on your keyboard. Just say press or type followed by the name of the key(s): 
any letter or number, but also Page Up, Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift, Windows... For 
instance: 

Say press spacebar    to select or unselect a checkbox. 

Say press F5     to refresh the view. 

Say press Alt e    to “click” a control labeled with an underlined ‘e’. 

Say press Control f    to open the Find field in most applications. 

Say press Escape    to “escape” out of a window. 

Say press Alt Down    to open a drop-down list. 

Say press Windows D   to show the desktop. 

Note: To undo a keystroke, you can say undo that. 

 

Exercise 2: Observe the Find and Replace dialog box below and its controls: tabs, drop-down lists, checkboxes, 
and buttons. Answer the following questions (think of “voice-typing” as well as “voice-clicking” options), 
then open a similar dialog in your word processor and practice navigating it by voice.  

• How could you place the insertion point in the Find field? How could you go to the other tabs? 

• Which control currently has the focus? How could you move the focus to the Find Next button? 

• How could you close this dialog box? 
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Remarks for Windows 8 and 10 

With Windows 8, Microsoft introduced major changes compared to previous operating systems, but it offers an 
interface similar to the familiar desktop. Applications such as Word and Excel open in that “classic” interface. 

The Start menu of previous operating systems doesn’t exist in Windows 8, but equivalent functionality is provided 
by the Charms bar and the Start screen. You can use the commands “open Charms bar” and “open Start 
screen.” (To see the expanded view of the Start screen, you can give commands including “show all 
applications.”) 

To perform actions, you can take advantage of Dragon’s ability to press keys. For example, you can give the 
command “press Windows key.”  

For the latest on using Dragon with a particular operating system, please see the Support page and 
Knowledgebase on the Nuance website (www.nuance.com/support/dragon-naturallyspeaking). 

 

Key points about controlling your computer by voice 
 At any time, no matter what is visible, you can open a Start menu or desktop item by saying start or open 

immediately followed by the name of the item. These two powerful capabilities can each be disabled or 
enabled from the Options dialog. 

 You can switch between open windows with commands like switch to Internet Explorer and list windows 
for Dragon. 

 To click menus, buttons, and other controls, you can “say what you see.”  

http://www.nuance.com/support/dragon-naturallyspeaking


 

Copyright  2016 Nuance Communications, Inc. All rights reserved 61 

 

 By default, Dragon requires the word ‘click’ just before the name of menus, buttons, and other controls: for a 
button labeled “OK”, say click OK. This can be useful to prevent unintended actions such as clicking Send in 
an email. Dragon offers a similar “Require ‘Click’” option for HTML links.  

 You can “voice-press” one or more keys by saying press followed by the name of the key(s). 

 Dragon offers “shortcut commands” to search your computer for items containing the word(s) you specify.. 
For instance, to find all indexed e-mails containing the words “Canada” and “budget”, you could say search 
email for Canada budget. 

 If it detected that your PC’s resources would not allow it to perform with both speed and accuracy, Dragon 
may have disabled its Natural Language Command sets for Word, Excel, PowerPoint and WordPerfect. If you 
wish to use Natural Language Commands in one or all of these applications, enable them via the Option 
dialog. 
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Using Dragon with the Internet  
This lesson introduces commands for typical Web-related actions, including shortcut commands. The Command 
Browser lists many more. Be sure to see the Help for details about using your voice on the Web and about Web-
related options.  

Note: Some commands that are supported in Internet Explorer are not supported in Chrome. See the Command 
Browser for each browser. 

 

The Web shortcuts 
Dragon includes commands you can say anytime to perform general Web searches, as well as searches in 
specific categories (maps, news, products, images, videos) or specific websites, such as Wikipedia.  

You could say for instance ‘search images for purple chrysanthemum.’ Dragon will then present, in your 
default Web browser, the results your default search engine found for those words in its image category. 

A key benefit of these “Web search shortcuts” is that they can be used no matter what program is currently active 
on your screen. No need to first open or switch to your browser! 
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TIP: These commands let you take advantage of capabilities of search engines. For example: conversions and 
calculations, as in ‘search the Web for 61 percent of 1500’ and ‘search Bing for 77 euros in dollars’. 

 

These shortcut commands can be disabled or enabled in the Options dialog. Controlled by the same option is a 
different type of Web shortcut command: open top site for… Instead of presenting search results, this command 
directly opens the website corresponding to the top result of the keywords you included in the command. Using 
such a command can be the quickest way to open the site for an institution or Web-based application: for 
example, you could say “open top site for Gmail” or “open top site for Nuance Communications.”  

Before these shortcut commands are executed, Dragon opens a small dialog box to let you revise, replace, or 
augment your keywords. Thanks to this, you make your searches very precise, which means you will find more 
quickly what you wanted.  

This Edit Search Keywords box is controlled by an option, enabled by default for Web and Desktop shortcut 
commands. Note: If you turn this option off, you may not see any action right away after giving one of these 
commands; the search engine needs a moment to complete the requested action.  

Social Media 
Dragon offers commands to quickly post to Facebook or Twitter. (If you wish to disable these, you can do so from 
the Options dialog.) 

There are two ways to create your post: 

• select some text in an editable document, then say "Post that to Facebook" or "Post that to Twitter."  

• append dictation directly in your command, as in the Web search shortcuts: say "Post to Facebook" or 
"Post to Twitter" immediately followed by the text you want to post. For example, “post to Twitter anyone 
know a great dentist in Burlington Vermont question mark.”  

Dragon then brings up a box where you can verify, complete or modify your text. Once you click OK, Dragon 
makes the post for you.  

  

Note: What Dragon executes with these commands is just making the post, as opposed to opening the Facebook 
or Twitter websites. Showing you the post itself in its site is not part of the command’s execution. If you wish to 
see your new post using voice commands, you could say “open top site for Facebook” and then say “refresh 
page.” 

The browser extensions 
The following sections cover actions often performed in HTML pages. There are many more commands; see the 
Help and Command Browser. Whenever you use Dragon on the Web (whether for email or for something else), 
your experience will depend on several factors, including: 

• the particular settings in your browser and in the Web-based application,  
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• the design of the particular web page,  

• the browser you use.  

For Internet Explorer and Chrome, Dragon offers its full functionality, including the ability to click objects by name, 
thanks to its Web extension, a small component you download for your browser. Please see the KnowledgeBase 
at support.nuance.com for the latest details.  
 
Your browser will present a message asking for authorization to install the Dragon extension.  
 

 
 

What Dragon can do differs among browsers. For example, in Chrome, Dragon doesn’t support the command “go 
to address bar”. 

Navigating to and within a Web page (Internet Explorer) 
Say go to address to go to the address bar; after entering a URL, say go there or press Enter. 

Say go back or go forward to click the Back or Forward buttons; say go home to access the homepage.  

Say add to favorites to add the current site to the Favorites list. 

Say refresh page (to stop a page load, you can say stop loading).  

Say page down or start scrolling down (then say stop scrolling). 

Say open new tab, switch to previous tab, close tab… 

Say next frame, previous frame, next pane… 

Say click close or press Escape to close a popup window. 

Accessing a specific item on a Web page 
These commands require the setting "Enable commands in HTML windows," which is on by default and can be 
found in  the Options dialog under Commands. 

 

IMPORTANT: Dragon is always looking to match what it hears to possible commands. For HTML windows, 
you can choose to require ‘click’, because saying a word or phrase in isolation may activate a link instead of 
being transcribed—see the Options dialog. This option is on by default.  
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For all the following commands, if what you said matches multiple items on the screen, Dragon displays numbers 
next to them; to indicate the desired item, say choose 3 or the number of your choice. (If you need the numbers 
to go away, just say hide numbers.) 

You can click inks or other objects by saying their name or just part of it, preceded by the word ‘click’ or not.  

You can also click objects 
by saying their type: 

click text field 

click image (note: 
some items look 
like text but are 
actually images.) 

click button 

click radio button 
(small circle) 

click check box to 
select or unselect a 
check box. 

click list box then 
show choices to 
display the list (to 
highlight list items, 
you can use go 
down n) 

You can also say show 
links, which numbers all 
clickable items on the page 

  

 

Key points about Dragon and the Web  
 Dragon includes commands you can say anytime to perform general Web searches, as well as searches 

in specific categories (maps, news, products, images, videos) or specific websites, such as Wikipedia. 

 The shortcut command “open top site for…” can be the quickest way to open the site of an institution or 
service, no matter what is active on your screen. 

 The shortcut commands can be disabled in the Options dialog.  

 Before executing these commands, Dragon opens a box which lets you revise, replace, or augment your 
keywords; this box can be disabled in the Options dialog. 

 Dragon offers commands to post to Facebook or Twitter; you can disable these from the Options dialog. 

 Dragon is always looking to match what it hears to possible commands. For links, Dragon requires first 
saying ‘click’ because saying a word or phrase in isolation could activate a link inadvertently. (This 
requirement can be turned off in the Options dialog.) 

 Dragon will prompt you to download the Dragon Web Extension for your browser. 

 For specifics on what Dragon can do in each Web browser, see the Help and the Command Browser. 
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Using Dragon for E-mail  
“Voice-typing” in itself is a great benefit for e-mail usage, but for certain e-mail applications, Dragon lets you do 
much more. This lesson introduces important commands and tips for using Dragon with e-mail, including shortcut 
commands and popular Web-based email programs.  

 

IMPORTANT: Although Dragon can automatically format email addresses and URLs as you dictate them, it 
can be efficient to add to the Vocabulary addresses and domains you use frequently (specify Spoken Forms as 
needed). Take advantage of Dragon’s tool for adapting the Vocabulary based on sent emails and finding Contact 
names to add. (See the Help menu’s Improve my Accuracy.)  

 

Shortcut commands 
Dragon has many commands for use in Microsoft Outlook, including in the Inbox (to forward, move, or flag 
messages, for instance) and in the Calendar.  

For creating messages, appointments, meetings and tasks quickly, Dragon offers “shortcut” commands that work 
no matter what is active on your screen. At any time, you can say for instance: 

• create email to Jane Miller and Payroll 

• schedule meeting with Joe Keller and Jane Brown 

• create appointment at noon 

• schedule appointment on August fifteenth 

• create task about office supply inventory 

• email the selection to Jane Miller (“the selection” being the selected text or file).  

You can see all wordings for these in the Command Browser’s “Dragon – Shortcuts for E-mail” Context.  

Note: Before using these commands, make sure Dragon is able to recognize unusual words such as the names 
you plan to mention (use the Accuracy Center).  

 

These shortcut commands can be 
disabled or enabled from the checkbox 
"Enable E-mail and Calendar 
commands" in the Options dialog. 

 

 

To see more commands, take advantage of the Help: for instance, say “search help for Outlook calendar.” 

Commands for your installed email program 
You can start your default e-mail program by saying Start mail.  

With the program’s inbox open, you can say: 

new mail – creates a new mail message 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 67 

 

open mail – opens the mail message highlighted in the list 

close mail – closes the open mail message 

forward mail – forwards the highlighted or open mail message 

reply to mail – replies to the highlighted or open mail message 

delete mail – deletes the highlighted or open mail message 

check for new mail – checks for new mail/opens your Inbox 

Note: In e-mail commands, you can substitute message, e-mail, or memo for the word mail. 

 

TIP: In lists of messages or folders, you can use navigation commands like go up 4 as well as go to top and 
page down. 

 

When in a message, you can move between its fields by saying Tab or the following commands naming the 
desired field (the word “field” is optional): 

go to To [field]  

go to CC | BCC [field] 

go to Subject | Body [field]  

 

Dragon has hundreds of mail-related commands. To find wordings for an action that interests you in a particular 
mail program, use the Command Browser: in its Browse mode, use the “Context” drop-down list to pick the 
program, then use “Keyword Filter” to enter one or more words related to that action.  

In Outlook, you can also use your voice to move the selected email to a particular folder. For example, if you have 
an Outlook folder called “Ideas” and want to move the selected email to it, you could say “move selection to ideas 
folder”. (To see more wordings, see the Command Browser under “Dragon – Shortcuts for MS Outlook.”) 

Web-based email and the Dragon extension 
Whenever you use Dragon on the Web, your experience will depend on several factors, including: 

• The design of the particular web page at that time  

• The particular settings in your browser and in the Web-based application  

• What browser you use. For example, you can’t the command “Go to Address Bar” in Chrome. 

For full functionality, Dragon will prompt you to install its Web Extension (a small component) in your browser.  
 

Full Text Control and the Dictation Box 
On most web pages, you have Full Text Control: Dragon capitalizes the first word, adjusts spacing, supports 
Playback, and supports commands that quote from your text, such as “insert before <xyz>” and “correct <xyz>.”  
In places without Full Text Control, such as in Google Docs, you can work through the Dictation Box. You can 
also work directly, in which case you will benefit from the following: 

• Say “cap” before the first word 

• If you need to insert within existing text, say “spacebar” to add a space. 
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Navigate fields and folders 
To access a particular folder, such as Drafts or Inbox, say “click” followed by the label. 
To navigate between fields, say “tab,” “tab n times,” or “click text field” then the number of the desired field.  

Note: 

• Whether using Dragon or not, it’s prudent to leave the To field blank until you’re ready to send! (Also 
prudent is setting up other protection such as an delay before the program actually sends.) 

• In addition to keyboard shortcuts of the Web browser itself, you may wish to take advantage of those of 
your particular Web-based email, such as “press control enter” to send a message in Gmail. Lists of 
shortcuts are available on the Web, including on the websites of Google and Microsoft.  

 

Key points about Dragon and e-mail  
 In e-mail commands, you can use the words message, e-mail, memo, or mail interchangeably. 

 For Outlook, Dragon lets you use shortcut commands like book meeting with <contact(s)>, create 
message to <contact(s)>, create email about <subject>, and create task about <subject>, at any 
time, no matter what application has the focus (no need to first switch to Outlook). These commands help 
you quickly act on a thought with minimal interruption to what you are currently doing.  

 Thanks to its Web extension for Internet Explorer and Chrome, Dragon offers Full Text Control in most 
websites (Google Docs and Word Online being exceptions) as well as the ability to click objects by name.  

 For the Web extension to be active after you download it, close and re-open your browser.  

 See more commands in the Command Browser and details in the Help (for instance, you could say 
“search help for Outlook calendar”). 
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The Office Ribbon and Microsoft Word 
In “Controlling the Operating System and Applications”, you learned about Natural Language Commands. Since 
Microsoft Word is a word processor many people use, this chapter lists built-in commands for it. (Remember: if 
system resources are low, enabling Natural Language Commands could decrease Dragon’s speed.)  

In addition to commands, this chapter covers a special point of interest for Word: the Voice Notation feature. 

 

The Ribbon interface 
Starting with Office 2010, Microsoft replaced application menus with a ribbon of tabs. The tabs display the 
controls that are most relevant for each of the task areas in the application, such as changing the font or zooming.  

This ribbon can be toggled on or off by clicking on the small arrow in the top right corner. To minimize the ribbon 
by voice, you can say “minimize ribbon” and to expand it, “maximize ribbon.” (In ribbon commands, you can 
also use the verbs “pin,” “show,” “toggle,” “collapse,” “expand,” “unhide,” and “view”.) 

The File tab 
The other tabs can be accessed by voice by just saying their name, but for the File tab you must include the word 
tab, as in “click file tab”.  

Note: Windows 7’s WordPad has an unnamed button instead of a File menu. To click it, you can say “click 
application menu”. 

Read Mode 
Word 2013 introduced a new layout called Read Mode, which aims to make it easier to read documents and 
perform related tasks such as obtaining the definition or translation of a word.  

When in Read Mode, you cannot use Dragon to dictate or perform selections or corrections in the open 
document, even though the DragonBar indicates that Dragon has Full Text Control. However, it is possible to 
dictate and perform operations when you are in a Comment field in Read Mode. 

For details on support for Office, please see Dragon’s Help and website.  

Discovering commands 
For popular applications like Word, Dragon has so many commands (and many different wordings for most 
commands) that we couldn’t possibly list them all here or in the Help.  

If you are in a supported application and you think of an action you’d like to perform by voice, use the Command 
Browser’s Context list to pick that application and use its Filter to see just the commands that contain a 
particular word or words. If you see a command that looks interesting, make sure it’s highlighted in the list, then 
use the Browse menu to uncover its full wordings (for instance, to include all optional words or expand ellipses). 

Note: If you say what you think is a command but Dragon takes no action or just transcribes the words on the 
screen, look for the Results indicator. If it doesn’t show your command, Dragon didn’t recognize what you said as 
a valid command for the current situation: for instance, if you say "insert a 2 by 2 table" when the insertion point 
is inside a table, nothing happens because Word doesn’t allow inserting a table inside a table 

Here are examples of commands for Word: 
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• New file 

• Save the file. Save file as. 

• Insert a 3 by 7 table  

• Add page numbers [at bottom left | center | right] 

• Delete next sentence 

• Find a word. Find and replace. 

• Set page orientation to Landscape 

• Print pages 3 to 7. Print the selection. Print [this] page 

• View page layout. Change view to print layout. 

• Zoom to 50 percent. Zoom to full page. Change zoom to page width 

• Set page width to 8 inches 

• Show | Hide paragraph marks 

• Double-space the document. Single-space this paragraph 

• Set the font color to green in this line 

• Set background to yellow 

• Show word count 

Here are more commands, grouped by their tab in Word’s Ribbon:  

Page Layout  
• Create a watermark 
• Set the page color 
• View themes 
• Create line numbering continuously. Delete line numbering 

References  
• Previous footnote 
• Create citation/caption/index 
• Add that in index 

Review  
• Open research pane 
• Translate first sentence. Translate entire page 
• Create new comment. Delete all comments shown. Go to next comment 
• Hide/close [the] review pane 
• Accept change and go to next 

“Voice Notations” in Word documents 

In Word, Dragon lets you add “Voice Notations”: text that can later be used with Word's Accept/Reject Change 
functionality. A Notation could be anything you do not want permanently in your document or you do not want 
transcribed, e.g. instructions you speak for the benefit of your assistant. Voice Notations are not used by the 
Acoustic and Language Model Optimizer.  

To add a Voice Notation, press the Esc key while dictating. Voice Notations are highlighted in green and 
formatted as red italic text.  
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Dictating and editing in Microsoft Excel 
You can use Dragon to dictate and edit content into Excel spreadsheets. Many Excel-specific commands are built 
in; the Command Browser lets you discover the full set. The Help describes commands to fill or hide rows or 
columns, sort, sum or average values, widen columns, and more. 

Remember that the Natural Language Commands for Excel may be disabled or enabled from the Options dialog. 

In this lesson, sample steps guide you to practice tasks such as entering text, moving between cells, editing 
existing cells, and correcting errors inside cells. 

 

IMPORTANT: If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3 
through cell H3”), be sure to say the word “cell” in your command. Note that, instead of the letters, you can say 
alpha, bravo, Charlie, etc. 

 

There are two editing modes in Excel: Quick and Full. Make sure you are familiar with how your version of Excel 
functions, especially for editing content in cells; notice when the Status Bar (bottom left) indicates “Edit” as 
opposed to “Enter” and when the mouse pointer changes. 

• Quick Edit: To enter new content into a cell, overwrite the current content of a cell, or format the entire 
content of a cell. When you select a cell and begin dictating, a yellow background appears; if the cell 
currently contains text, the dictated text will overwrite it. 

• Full Edit: To edit the existing contents of a cell. Select the cell and say "Edit Cell" or "Press F2" to open 
the cell for editing; the insertion point is automatically placed at the end of the cell. As you dictate, the 
background changes to blue. Commands such as "New Line" operate within the cell.  

 

TIP: To quickly enter a predictable series of values, such as days or months, you can use commands such as 
“Monday through Friday across” or “July through December down.” 

 

 

Full Text Control in Quick Edits 
You will want to practice entering data into a spreadsheet and navigate around the spreadsheet and within cells, 
as well as dictate and modify text using commands like “correct <xyz>” (see Full Text Control). 

For the exercise below, the content of the spreadsheet is not important.  
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Step 1: Open Excel, say open document and locate 
the sample spreadsheet or use a blank file.  

Step 2: Say move to cell C7 (or Charlie seven.)  

Step 3: Dictate your full name into the cell. 

As you dictate, the cell background turns pale yellow, 
indicating that Dragon is doing a Quick Edit. 

 

 

 

Let’s practice correcting recognition errors so Dragon can learn from them: 

Step 1: Say move to cell C 14 (or Charlie 14). Dictate some text that is likely to contain unknown words, such 
as: “Travel to Ashtabula to provide support for Sporkatron, Inc.” 

Step 2: Correct one of the recognition errors. (Leave the remaining errors as they are, so you can practice 
coming back to this cell and correcting them later.) 

Step 3: Say move down one to go to cell C14. Dictate some additional text that is likely to contain new words, 
such as: “related to last week’s trip to Kenmawr—training Moosehart Insurance” 

 

Now that you are out of the cell, practice going back to it and correcting the error(s) in it. 

Step 1: Say move up one to move back to cell C13. Say a “correct <xyz>” command to correct another of the 
errors Dragon made. Notice that the cell again turns yellow. 

Continue correcting the text until it is accurate. 

Step 2: Say apply. You are no longer in Quick Edit mode; the cell you were editing is still selected. 

 

Now let’s practice entering numeric data rapidly into a row. 

Step 1: Say move to cell B16 or move to cell Bravo 16 to move to the Breakfast row. Dictate a numeric value 
such as six dollars and fifty cents. 

Step 2: Say move right one to move to the next Breakfast entry. Fill in the rest of the row. 

 

Key points about editing cells in Excel 
 You can navigate between cells using absolute commands such as move to cell A1 or relative 

movement commands such as move up 1. 

 To mention a cell in a command (such as move to cell D5 or select cell B3 through cell H3), be sure to 
say the word “cell”. You can speak the letters as alpha bravo Charlie, etc. instead of A B C.  
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 To modify and add to the existing content of a cell, move to that cell, then say Edit Cell or Press F2; the 
insertion point will appear at the end of the content and the cell will have a blue background. If you say 
commands like New Line and New Paragraph, these commands are executed within the cell. 

 If you just move to a cell and start to dictate, what you dictate will overwrite the existing content. 

 You can use commands like correct <xyz>, and insert before <xyz> to modify text in a cell. 

 To complete entry and move down one cell, say press Enter. To cancel entry and remain in the cell, say 
cancel or press Escape. 

 Saying apply completes entry into a cell, and leaves the focus on that cell (exiting Quick Edit mode). 
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Boosting Productivity with Custom Commands 
In previous lessons, you learned various built-in commands to perform actions such as formatting text, searching 
the Internet, creating a new e-mail, creating a new appointment… Dragon also allows custom commands. 

There are several types of custom commands; this workbook presents the “Auto-text” (“Text-and-Graphics”) type, 
which allows you to define boilerplate for Dragon to paste wherever you utter the command. This boilerplate can 
contain graphics, such as logos, scanned signatures, maps… Easy to create, these commands provide additional 
time savings and convenience. You can even include fields in them—a quick way to create templates that can be 
both created AND navigated by voice. 

Creating boilerplate commands 
Step 1: Say add new command or choose Add New Auto-Text or Add New Command in the Tools menu.  

Step 2: Think of a name for your command and enter it. This is the phrase you will say to cause the 
command to execute. Choose it well! It should be easy to remember and easy to say, like Paste 
Signature and Enter Home Directions. 

 

 

• Choose a descriptive, meaningful name (as opposed to a name like “macro 3”.) 

• Make it neither long nor short (between 2 and 5 words is usually best). Avoid single words, and phrases 
you’re likely to dictate, such as your name. 

• Use words that are easily pronounced and recognized. All words in the command name must be in the 
Vocabulary.  Don’t use symbols—for instance, use “number” instead of “#”, otherwise Dragon would 
expect to hear “number sign” or “pound sign” when you say the command. 

Step 3: In the Description field, enter information about your command. This is optional, but it helps remember 
any important details about the command (its intent, when and where you might use it…). 

The following step applies to the MyCommands Editor as opposed to the Add New Auto-Text window. 

Step 4: Optionally, choose a group. In the Group field, you can highlight and overwrite the default. Creating 
commands groups can later allow you to locate and manage many commands quickly. Aim to name your 
groups meaningfully: for instance, the name of the application or task for which you are creating the 
command(s). 

Once a command Group is defined, you 
can add more commands to that group 
(Dragon will now include it in the “Group” 
drop-down list). 

If desired, you can always assign the 
command to another group later. 

 

Step 5: In the body field, enter what you want Dragon to paste when you say your command. (You may find it 
helpful to maximize the window so that a larger field is visible.) 

 

TIP: If the text you want already exists in electronic form, you can save time: highlight the desired segment in 
the document, then say “make that a command”. Dragon automatically opens the Editor and pastes your 
selection in the Content field. All you have to do now is specify the command’s name and attributes, and edit the 
content as needed.  
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As its name suggests, this type of custom command lets you include graphics as well as text: you can 
paste images from another application into the Content field—maps, logos, or scanned signatures, for 
instance. 

Optional: If desired, format the text entered in the Content field: you can use the buttons (bold, left-align, 
center…) below it. Clicking the Aa button opens the Font window, where you can choose the desired font 
style, size, color, etc.  

 

 

TIP: If you want the content to match the format of what precedes it in your document, check the Plain Text 
checkbox. 
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Step 6: Once the command is named, edited, described, grouped, and formatted as you want it, click Save. 

Now let’s test your command. Say start DragonPad, then say your command’s name. (Follow the usual rule: 
pause before and after, but not in the middle!)  

You may realize now that you could make your command even more convenient: for instance, by adding a blank 
line at the top so your pasted content automatically starts as a new paragraph. The below explains how to edit a 
custom command. 

“Cloning” commands and adding variables 
Instead of making a command from scratch, you can create a new command based on the “clone” of an existing 
one, by clicking New Copy on the Command Browser’s menu or by clicking the Create New button on the 
MyCommands Editor. 

In addition, the MyCommands Editor’s Name Editor allows the inclusion of <variables> in your command names. 
Variable names provide flexibility, so you can use synonyms instead of just one wording, and can make your 
custom commands even more useful by having them perform variations on the same action.  

The variables can be synonyms, or they 
can be different values, such as 
numbers from 1 to 10.  

<1to10> is one of the pre-filled lists 
available through the Name Editor, but 
you can also make your own (as was 
done for <hq_nuance> in this lesson’s 
illustrations).  

See the Help for details. 

 

 

Boilerplate commands with fields 
Dragon lets you easily paste a template containing voice-fillable fields. To create a field in a command’s body, 
click the Insert Variable button in the Command Editor. By default, each field appears between square brackets 
as "[default value]". (If you prefer delimiters other than square brackets, you can indicate that in the Options 
dialog.) 

After saying the command’s name, which pastes the template, you can: 
• type or dictate a specific value in each placeholder —> The placeholder is overwritten, and delimiters 

are removed. 
• accept the default value —> Delimiters are NOT automatically removed; you can say "clear variable 

delimiters". 
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To navigate a template’s fields, you can select the desired field with the mouse or use the commands "next field" 
or "previous field." (These commands only work where all of Dragon's functionality is supported—where the 
DragonBar’s Full Text Control indicator is green). 

Managing custom commands 
After you create commands, you may wish to edit them. If your phone number changes, for instance, you may 
want to edit commands containing it. You may also want to rename, delete, or copy commands. To do so, you 
can open the Manage Custom Commands dialog box, from the Tools menu. 

The Command Browser lets you search for commands as well as manage your custom commands. Deleting, 
renaming, modifying, exporting and importing custom commands can be done through its Manage “mode”, as 
follows.  

Step 1: Say open Command Browser. (You can also use the link in the Tools menu.) 

Step 2: On the Mode section of its Task Pane, click Manage (or choose it from the Mode menu). 

Step 3: Open the Group drop-down list. If you created a separate group as mentioned earlier, its name will 
appear here; choose it. Otherwise, the commands you made will be under User-defined. 

Step 4: The Command Browser now displays only the commands in the specified group, listing them by 
availability. You can use the + symbol to expand the display. 

Step 5: Check the box next to the desired command, then click To Script which at that point will be available in 
the Task pane.  

 

 

This takes you to the Command Browser’s Script display, which shows all the modifiable commands. 
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Step 6: With your command highlighted, click Edit in the Task pane (or use the Script menu). The MyCommands 
Editor will open, displaying the command’s attributes and content; you can now edit them as desired. 

Note: 

• You can delete commands visible through the Script or Manage displays: check the box next to the 
desired command(s) then choose Delete (from the menu). 

• Giving your command a Description is useful for entering comments such as where and when the 
command should be used, or reminders like “make variations of this ASAP” or “change this after we 
move”. Your notes may seem obvious at the time you write them, but they may really help later! 

Finding commands: the Keyword Filter 
One of the ways you can find commands in the Command Browser is by using the ability to filter the display to 
show only the commands whose name contains a particular word or words: choose Filter from the Command 
Browser’s toolbar (visible in the upper-right corner when in Browse Mode) to specify one or more words. The 
Filter button is useful for finding custom commands (particularly if they were not filed under a Group name), and 
also for finding built-in commands, since Dragon contains far too many to list even in the online Help.  

 

TIP: It’s a good idea to explore the Command Browser for commands related to items you might like to address 
by voice: you might filter for words like border, indent, double space, table, row, column… 

 

The Command Browser’s display may seem strange at first, because instead of full words some lines may contain 
ellipses (dot dot dot), parentheses, and <angle brackets>, in order to fit in the space and represent the many 
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optional and alternate elements, like “the” and “a”. You can view the full wordings by using the Browse menu’s 
items—Refine and Undo All are particularly useful. 

To practice, pick your usual word processor in the Context drop-down list, and use the Filter to find commands on 
items you often use in this application.  

 

Key points about custom commands 
 You can quickly create custom commands to insert blocks of text and/or graphics in your documents. This 

can be done in the Add New Auto-Text Command window, from the Tools menu.  

 If the boilerplate text already exists in an electronic document, you can save time when creating the 
command: select the text then copy and paste it or just say make that a shortcut. 

 It’s a good idea to use the Command Editor’s Description field to note a comment or a reminder, for 
yourself or potential other users of your command. 

 Names for custom commands should be memorable, intuitive, easy-to-pronounce phrases. Avoid names 
that Dragon could recognize in the course of your dictations, such as single words.  

 The Name Editor lets you add <variables> in command names, to provide synonyms or variations, using 
lists you define yourself or existing lists such as <1to10>. 

 You can add fillable fields to your boilerplate commands to create templates which can be navigated and 
filled out by voice. 

 You can rename, modify, copy, delete, export and import custom commands.  



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 80 

 

Performing Audio Checks and Training 
As described earlier, personalizing Dragon’s vocabulary is a small investment of time that makes a big difference 
in how accurately the software can work for you. In addition, when misrecognitions do happen, correcting them 
allows Dragon to learn from its mistakes.  

In certain cases, you may also want to perform acoustic training to improve accuracy. This lesson presents how to 
train individual words or phrases, as well as how to use the Microphone Check, a short but important process. 

 

IMPORTANT: When providing Dragon with acoustic training, be sure to use your natural dictation voice: 
relax, and speak clearly but not louder or slower than you would when dictating normally. Otherwise, you give the 
software acoustic data that is not representative of how you usually dictate. Remember, to train the software to 
accurately recognize your speech, you must represent your speech accurately! 

 

The Microphone Check 
Use Dragon’s audio check if something in your environment has changed: new computer, new microphone, new 
room, different ambient noise, etc. Also, if your overall accuracy is lower than expected, you want to verify that 
your audio hardware is functioning correctly.  

Note: when this Wizard opens, Dragon automatically turns off its microphone. 

Step 1: From the Audio menu, click or say Check Microphone, which opens the microphone check wizard 
(formerly called the Audio Setup Wizard). You can also bring it up directly by saying check microphone. 

Step 2: As when you first created your profile, read the content of the box. Dragon will indicate whether the check 
passed. If it failed, verify that your microphone is plugged in correctly and its listening side is facing your 
mouth. (The listening side may have under the foam cover.) There may be a problem with background 
noise (including “subtle” noises such as your building’s temperature-control system) or with your audio 
hardware. See the Help button. 

Acoustic training in isolation 
You have learned to add new words and phrases to the vocabulary, as well as to create Spoken Forms for items 
pronounced differently from the way they are written. Spoken Forms are often the most efficient way to ensure 
accurate recognition. 

If you suspect that Dragon needs help recognizing a tricky word, particularly if it contains one or more sounds you 
cannot represent in a Spoken Form (such as a rolled r), you can “train” that word. 

Step 1: In the Vocabulary Editor, locate the word you wish to train. 

Step 2: Click the word in the list so it is highlighted, then say or click Train. The Train Words window opens. Are 
you ready? (If you need to clear you throat, do it first!) Click Train and read the prompt in your normal 
speaking voice, as if you were saying this word in the middle of a sentence. 
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Step 3: You may have to 
wait a second for 
this acoustic 
information to be 
incorporated. Then 
click Save. 

 

  

Key points about acoustic training 
 In general, the best thing you can do to make Dragon recognize your speech even better is use the 

software regularly, personalizing the Vocabulary (editing Spoken Forms or Word Properties as warranted, 
designating documents for Dragon to analyze, running or scheduling the Accuracy Tuning process…) and 
correcting misrecognitions.  

 In certain cases (if a certain word is consistently misrecognized, or if overall accuracy is lower than you 
expected), you will want to provide Dragon some additional acoustic data. 

 You can train Vocabulary entries from the Vocabulary Editor (either one at time or several at once). 

 Speak as you typically do when you dictate to Dragon. It’s important to avoid the temptation to over-
enunciate or speak loudly when training a word or phrase in isolation. 

 At any time, if you feel that the accuracy is not as high as usual, you can access Dragon’s Microphone 
Check through the Audio menu or the Accuracy Center, or by saying Check Microphone. 
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Using Multiple Vocabularies 
The advantage of having several Vocabularies is being able to customize each one to perform best for very 
different topics or styles of dictation. For instance, suppose an architect uses Dragon to dictate business letters 
and site reports, but also frequently uses it for his community theater group. In his work-related dictations, he 
might use formal business language and mention technical terms, brands of materials, the abbreviations for 
building codes, as well as the names of clients, contractors and other work contacts. When writing for his theater 
group, however, his dictation style might be casual and the words he uses frequently would be different. 

The Help contains details about creating and managing vocabularies. This lesson presents the essentials.  

 

Creating a vocabulary 

The process starts in the Manage Vocabularies dialog 
box. 

Step 1: Say Manage Vocabularies or use the 
DragonBar’s Vocabulary menu. Click New.  

 

Step 2: In the New Vocabulary window, enter a 
descriptive name in the Name field. From the 
drop-down list, choose the vocabulary on 
which you want to base your new vocabulary 
(what you see in the list varies if you have the 
Legal edition): 

 

• If you want your new vocabulary to contain the customizations already present in your existing 
vocabulary, choose this existing vocabulary: e.g. General – Large. 

• Otherwise, choose the Base vocabulary.  

 

Step 3: Dragon will then offer to perform a basic adaptation of this new vocabulary based on documents found on 
your computer, or sent emails (this is similar to what Dragon offers when you create a profile).. This 
automatic process may take a while, and is not as powerful and targeted as the other vocabulary tools. 
You can choose Cancel, then customize your new vocabulary using what you learned in previous 
lessons. Remember that designating documents for Dragon to analyze is particularly important for good 
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accuracy, in addition to adding written forms and spoken forms to the vocabulary… (see the Accuracy 
Center). 

 

Managing Vocabularies 
After creating (or importing) a new Vocabulary, you may wish to rename or delete it; both are done in the Manage 
Vocabularies dialog box, accessible from the DragonBar’s Vocabulary menu.  

From there, you can also Export a Vocabulary, to burn it to a disk or save it to a USB drive, for instance.  

This would allow you to share it with other users of Dragon: the recipient user just needs to open the Manage 
Vocabularies dialog, choose Import and browse for the exported Vocabulary’s .top file. (See the Help for more 
details.) 
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Opening a Vocabulary  
During your dictation session, you can switch to a different Vocabulary by saying open recent vocabulary. 

If you have multiple Vocabularies for the same profile, this will be reflected in the Open User Profile window, 
which will appear when you start Dragon. 

The Open User Profile window also shows the different audio source(s) that may be available for the profile(s) 
present on your computer.  

You can pick the line containing the Vocabulary you wish to open.  

  

  

Key points about multiple Vocabularies 
 If you dictate on two or more very different topics, using different customized Vocabularies will maximize 

your recognition accuracy. Each Vocabulary can be customized using the tools in the Accuracy Center—
adapting to documents you designate, for instance. 

 If you have several Vocabularies, you will be prompted to choose one when you start Dragon. You can 
switch to a different Vocabulary later, by saying open recent Vocabulary, for instance. 

 The Manage Vocabularies dialog lets you create, delete, open, rename, import and export Vocabularies; 
it opens with the command manage Vocabularies (or from the Vocabulary menu). 
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Acoustic and Language Model Optimization 
Vocabulary customization and proper correction of recognition errors both help Dragon recognize your dictations 
more accurately. “Accuracy Tuning” is a functionality you can use to further “tune” your profile’s accuracy for your 
specific usage. It has two aspects: 

• refine your profile using the latest acoustic data from your dictations, corrections, and transcriptions.  

• use text from your usage to add frequent word sequences to the Language Model -- statistics Dragon 
uses to determine what words and spellings it should write when you dictate. 

 

IMPORTANT: If you have recently dictated in a very different sound environment, such as an airplane, you 
should not let Dragon perform Acoustic Optimization. 

 
 
When your profile is saved (for instance, when you close Dragon or your profile), Dragon may offer to optimize the 
Language Model based on the text data of your recent dictations. The Save User Profile dialog box will contain a 
checkbox for performing “maintenance.” Note: This process takes little time. Language Model Optimization is 
much quicker than Acoustic Optimization because the data it processes is just text. 

The Accuracy Tuning process becomes available once you have used Dragon for a while (the software builds up 
an archive when you perform dictations, corrections and training). A message box will let you know once Dragon 
has enough for its automatic optimization. 

How much of an accuracy boost you will get from Accuracy Tuning will depend on factors such as the amount and 
quality of the initial training and optimization (if performed during profile creation), the initial accuracy you 
experienced, and the amount and quality of text and audio data available for processing. 

You can choose to schedule the two components, Acoustic Optimization and Language Model Optimization, to 
run periodically at a time and frequency of your choice. You can also launch one or both yourself. 

Launching the Acoustic and/or Language Model Optimization 
Step 1: Use the Audio menu (or the Accuracy Center’s Accuracy Tuning link).  
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Step 2: Check the optimization(s) desired then click Go. Note: Language Model optimization is typically much 
faster than Acoustic Optimization. 

Scheduling Optimization and User Experience Collection 
For convenience, Dragon lets you schedule a specific time and frequency for these optimizations. You can do this 
at the time you create your profile, and you can also do it later by going to the Administrative Settings dialog 
(available from the Tools menu) and using its Scheduled Tasks tab. 

 

IMPORTANT: When you schedule a Dragon task, pick a time when your computer will be on (not 
sleeping, not hibernating) but Dragon won’t be running (not even in its QuickStart mode). 

 

The documentation contains details about how end-users and Administrators can access these optimizations and 
Dragon’s scheduling (the latest documentation is available on the Nuance website).  

 

In addition to Accuracy Tuning, Dragon allows you to enable and schedule another periodic task: the automatic 
collecting of anonymous data on your usage (such as which optional settings you have, which commands you use 
often, how often you make corrections, which language you use, which processor is on your computer, what 
version and edition of Dragon you have) over the Internet. This option helps Nuance’s Research & Development 
team learn what customers around the world need, in order to improve future releases of Dragon. You can 
choose to disable or enable it at any time.  

Take a look at the Data page of the Options dialog. Note that it includes the setting for the frequency at which 
Dragon makes a backup of your profile (by default, Dragon does it every five times your profile is saved). 
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Key points about optimization 
 Acoustic and Language Model Optimization can automatically “tune” your profile by “reviewing” the 

acoustic data and/or text data it has gathered from your usage of Dragon so far.  

 Optimization can be launched at any time from the Audio menu or the Accuracy Center. It can also be 
scheduled, so that Dragon performs it at a specific frequency and time.  

 Language Model optimization is typically very fast. You can schedule it to run daily. 

 When scheduling Accuracy Tuning or User Experience Collection, pick a time when your computer will be 
on but Dragon won’t be running. 
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Renaming, Deleting, Copying or Transferring a Profile 
As you learned, each person who uses Dragon creates a User profile, which the software holds in a set of files 
that contains, among other things, acoustic and lexical data. When you add a personalization to the Vocabulary 
(spoken form, alternate written form, capitalization property…), correct a recognition error, read a training text, or 
change an option, Dragon can save these changes in the open profile.  

Although Dragon automatically creates a profile backup (by default, every five times the profile is saved), it is a 
good idea to keep your own record of customizations, by exporting your custom words for instance, or noting what 
Word Properties you have changed.  

You can also copy your whole profile, for safe-keeping or to make it available on another computer. Transferring a 
profile is a simple two-part process accomplished through the Manage User Profiles dialog box.  

 

Step 1: Say manage user profiles (or choose Manage User Profiles in the Profile menu). In the Manage User 
Profiles dialog, select your profile, then choose Advanced then Export. (You may see a message about 
saving changes to the current profile.) 

Step 2: A Browse dialog opens. Choose a destination (if you wish, make a new folder) then click OK.  

If both computers are on a network with a shared drive, this drive is probably the easiest location. 
Otherwise, you can export your profile to a media storage device, such as a portable USB drive.  

 

Now that your User profile is exported, it can be imported:  

Step 1: From the second computer, open the Manage User Profiles 
dialog. Choose Advanced> Import. 

Step 2: When the Browse window opens, locate the folder containing 
the exported profile (this folder bears your profile’s name). 
Once it is highlighted, click OK. 

 

 

 

The Manage User Profile dialog box also enables you to rename or delete a profile, as well as to see a profile’s 
Properties (such as its source(s), backup location, and date of last backup). 
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Key points about exporting and copying a profile 
 Transferring a profile is done through the Manage User Profiles dialog box—available through the Profile 

menu or by saying manage user profiles. 

 You must export the profile from the original computer, then import it to the recipient computer. 

 

The Help contains more information about managing profiles: deleting, renaming, backing up, restoring… See for 
instance topics on Dragon’s Roaming User feature which presents administrative advantages and is particularly 
useful for people who frequently dictate from different PCs connected to the same network. 
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Practice Exercise: Creating a Memo by Voice 
For this exercise, open DragonPad or another supported word processor. Try to create and format the following 
document entirely by voice. After you create the sample signature block shown in the sample below, replace it 
with your own contact information.  

Take this opportunity to practice looking up keywords in the Help to find out more ways to accomplish a particular 
task. Remember the commands “what can I say” and “search Help for…” as well as “quote that”! 

 

 
August 5, 2016  

AnyCorporation 
Gene Hansen-Wolffe 
P.O. Box 3299 
Minneapolis, MN 67812-3299 
 
 
 
Dear Gene, 
 
I am pleased to report that “my” team has reviewed the Western Region Report for this quarter. As of 
July 29, 2016:  
 

the total is $875,500 [as we expected]. 
 
Please let me know your projected figures for the rest of Q3.  
 
As always, don’t hesitate to contact me at the number below. 
 
Sincerely, 
 
Sara Petersen 
Regional Sales Manager 
My Company, Inc. 
202-965-5000 
mobile: 715-377-1925 
fax: 800-968-2231 
sara.petersen@mycompany.com 
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